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Introduction 
What is RPM? 
RPM Remote Print Manager® is a TCP/IP print server for Microsoft Windows 95, 98, and Millennium Edition 
platforms using native TCP/IP networking.  There are also versions available for Microsoft Windows NT/2000/XP, 
Windows 3.1, and Windows for Workgroups 3.11. 
 
RPM allows print clients to send print requests directly to a PC over a network. RPM supports the LPD Protocol for 
Internet printing, and the associated UNIX print commands lpr, pr, lpq, lprm, lp, and lpstat. 
 
RPM was designed to run, after initial setup, without manual intervention. 
 
RPM supports multiple named queues. It allows you to choose any printer available from Windows, and stores any 
print setup selected for a specific queue. It also supports fonts, margins, line wrap and many other text features. RPM 
will pass print data directly to a printer without modification, open the data in a program, or save the data to disk 
instead of printing. 
 
RPM has been tested extensively with all the major PC network software including the Microsoft Windows for 
Workgroups TCP/IP, Novell, and Trumpet. RPM accepts requests from mainframes running MVS, CMS, and CICS; 
from UNIX workstations; and from PC-clients with a supported LPR application. 
 
RPM is a fully featured and supported product, and is the only professional LPD server available separately from 
bundled networking suites. We believe it is the best LPD server available anywhere. 

What is LPR/LPD? 
LPR/LPD is the printing method most commonly used in TCP/IP networks. LPR/LPD is used extensively on university 
and business campuses where UNIX systems have been in place for a while; the new generation of operating systems, 
for both mainframe and desktop, now support TCP/IP and LPD as well. It is a computer-to-computer printing method, 
rather than PC-to-PC. LPR stands for Line Printer Request; it's the part that submits the print request. LPD stands for 
Line Printer Daemon; it's the part that receives and processes the request. A "daemon" is a server or agent. 
 
The LPD Protocol Specification is documented in RFC 1179, Line Printer Daemon Protocol, dated August 1990, edited 
by L. McLaughlin III. 
 
RFC stands for Request for Comments. The RFCs document Internet protocols, practices and proposed standards. They 
are available via anonymous FTP at http://www.ietf.org/rfc. 

RPM Features 
Named queues 
RPM supports multiple named queues (see "Queues" on page 8). There is no fixed limit to the number of queues. 
Each queue has its own setup information. Queues operate independently of each other. Each queue has its own printer 
setup (page 51) and queue type (page 8). You can configure separate queues for the same printer, each with different 
characteristics. 
 
Queue types (page 8) include text queues, which support many print options; pass-through queues, which send data 
directly to the printer; and filter queues, which run a program on your PC rather than printing directly. 
At any time in RPM you can create a queue (page 14), rename a queue (page 15), delete a queue (page 14) or jobs in 
the queue (page 24), and edit the settings in an existing queue (page 14). 
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Print Options 
•  RPM supports all the print options available through standard Windows Print Setup dialog. Each queue uses 

its own print options, so you could create a number of RPM print queues, each with separate print options, to 
fully support your printing needs. 

•  RPM supports both local and network printers, for text and pass-through queues.  If Windows supports your 
printer, then RPM can print to it. 

•  RPM prints the optional banner page; RPM also allows you to suppress printing banner pages for a queue. 
•  RPM supports pr style printing, using the optional page headers. 
•  RPM has many features requested by mainframe users, including suppressing trailing blank pages, removing 

null characters from a printout, line wrap options, lines per inch and characters per inch, overprinting, and 
scaling the font down to support a given line length. 

User Interface (UI) 
•  RPM displays comprehensive information on queues (see "Queue Status window" on page 18), active jobs in 

queues, jobs waiting in queues, print jobs (see "Print Status Window" on page 22), and all logged events (see 
"Log window" on page 20) in separate, independent windows. 

•  Queue operations are available through the menus, but are hot-wired into the Queue Status window for 
convenience. 

•  All windows support Copy (page 24) to clipboard. 
•  RPM supports a wide range of logging options (page 16). 
•  RPM uses a workbook interface rather than cascading windows.  Both the Queue Status and Log windows are 

always open. 
•  RPM displays dates and numeric data in Windows using the regional settings. 
•  Only one RPM session runs at a time under Windows 9x. 
•  RPM saves the size and location of the main window. RPM does not need to be visible to operate. The child 

windows are for display purposes only, and they do not need to be open for RPM to operate. 
•  RPM supports context sensitive help. You can get help for every window, menu item, and dialog by pressing 

the F1 key or using the Context Help  button on the toolbar. 

Support 
RPM includes a number of features to facilitate problem solving, including copying window contents to the clipboard 
and the extensive logging options. 
 
Our policy is to resolve problems to the best of our ability, and to cooperate with other vendors.  We are very interested 
in your impressions of RPM. If there is anything we can do to make RPM more useful for you, please don't hesitate to 
contact us. See page iii for contact information. 

Requirements  
What does your computer need in order to run RPM? If it runs Microsoft Windows and TCP/IP is installed, it will also 
run RPM.  Other requirements are needed depending on the usage of RPM. 

•  Intel compatible computer, 486SX Minimum, Pentium recommended. 
•  Microsoft Windows 95, 98, or Millennium Edition 
•  Windows Sockets version 1.1 or later compatible network software. Your system must have the file 

winsock.dll or RPM will not install. 
•  Minimum RAM: 8 megabytes; we recommend at least 32 megabytes depending on utilization of computer or 

other operating system requirements. 
•  3.0 MB for installed executables and other files 
•  Adequate disk space for incoming print requests-recommended minimum 2 MB 
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•  Optional: One or more printers configured to work with Windows. Printers are 'optional' because RPM can 
save files to disk or open them using a local program on your computer. 

Installing RPM  
RPM is distributed with a Windows setup program which installs the RPM software on your computer.  The setup 
program installs the RPM software in its own Program group, but you can move those icons to any other location 
without affecting RPM. 
 
Here's the step-by-step install process: 

1. If you have RPM on disk, insert the disk in your computer. Go to the Windows 'Start' menu, select run.   Type 
'x:\setup.exe' substituting your drive letter for ‘x’ and press OK.  Or you can install from the Add/Remove 
programs option in the control panel.   If you have the downloaded RPM executable, simply double-click the 
file to begin the installation. 

2. Take note of the End User License Agreement. Please review it to make sure the terms are understood. Click 
either ‘Yes’ or ‘No’ to represent your acceptance of these terms. The setup program will continue only if you 
accept. 

3. Setup presents a suggested path for the RPM install folder. Change this path as needed and click Next to 
continue with the installation. 

4. Setup then suggests a program folder to install shortcuts to commonly used files.  Change this name if needed 
and click Next to continue. 

5. RPM will now be installed. You will see a progress bar which shows the percentage completed, and messages 
that describe the various components. Setup then adds an RPM program group to the 'Start' menu.  A copy of 
the End User License Agreement is installed along with RPM program and help files.  

6. RPM is now installed.  To begin using RPM, click the RPM program icon (by default, it is titled "RPM"). 
 
Each time you run RPM it: 
 

•  Checks for a valid license. If the product license is unlocked, or if it is in the trial period, then RPM continues. 
If the license is expired then RPM displays a message and opens the Brooks License Manager. 

•  RPM calculates the number of currently defined queues. If there are no queues, RPM presents the New Queue 
dialog and the Edit Queues dialog repeatedly, until you click the Cancel button in the New Queue dialog. 

 
When you are finished defining queues, click Cancel in the New Queue dialog. RPM is now operational.  You should 
remove any previously installed versions.  You can also place a shortcut in the Startup program group so that RPM 
starts automatically when a user logs on. 

Configuring Remote Clients for RPM 
Minimum requirements 
The minimum information you need to supply to your remote print client is the host name of your PC, and a queue 
name. For more information on these terms, see the Glossary in the back of this book. 
 

  Note: there is no default queue in RPM. You must create at least one queue. When RPM is started the first time, 
the “Create a Queue” dialog is displayed.  See page 34 for more information. 

What to Name your RPM Queue 
When a print client makes a request for a queue that is not defined, RPM automatically creates a queue with the 
appropriate name.  You can turn off this "Auto-Create" feature in the Settings Dialog.  If "auto-create" is turned off and 
RPM receives a request for an undefined queue, a warning is logged. 
 
It is not always easy to see the warning that RPM returns.  To determine which queue name the client is using: 
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•  Open the Log window if it is not already open, by selecting Log from the View menu or clicking the Log tab at 

the bottom of the main RPM window. 
•  On your remote system, rerun the command. 
•  At the bottom of the RPM log window, check for a message similar to this:  “Warning: Queue 'test' is not 

defined.” 
 
In this example, test is the name of the queue the remote client is using. You should either reconfigure your remote 
client, create a queue (page 14) in RPM with the same name, or rename an existing queue (page 15).  You can also 
enable the “auto-create” feature in RPM (page 53). 

Choosing the Right Protocol for Your Client 
RPM currently supports the LPR/LPD protocol, sometimes known as the Berkeley remote printing protocol. RPM also 
supports streams or reverse telnet; see page 55 for more information.  Future versions of RPM may support a wider 
variety of protocols. 
 
Brooks Internet Software does not currently have access to all the varieties of systems our customers print from. Based 
on our experience, we can offer the following guidelines to help you pick the right buzzwords if you need to select a 
protocol: 

•  If you see a choice for LPD, pick that one 
•  If you see a choice for remote Berkeley or remote BSD, pick that one 
•  If you see a choice to emulate an LPR client, pick that one 
•  If you have a Berkeley compatible UNIX system, consult the printcap man pages for assistance. 
•  If you have a System V compatible UNIX system, do not use lp; use Berkeley compatible. You will need to 

consult your documentation or a local system administrator for details. 

Order of Control File vs. Data File 
Some LPD servers expect the control file to follow the data file(s); others may expect it to come first.  RPM receives 
files whether the control file comes first or last. 

User ID 
RPM does not currently require the user to supply an ID. 

Client Port and TCP/IP Protocol 
Certain clients may not follow the TCP/IP server conventions.  By default, RPM relaxes these conventions so a wide 
variety of systems can print to RPM with little configuration modifications.  See "LPD Options Dialog" on page 45 for 
more information. 

Common Printing Problems 
To facilitate solving problems, RPM maintains a log and provides a window to view it.  The window is open by 
default; to access it, click the date-stamped tab at the bottom of the RPM window.  If it is not open, select Log from the 
View menu.  This window will contain a number of entries from RPM startup, including version information for RPM 
and Windows Sockets. 
 
This section refers frequently to Edit Queues, which is the Edit Queues dialog discussed on page 36.  If you are 
experiencing trouble, first increase the level of detail logged from the Log Options dialog (page 45). 
 
Is your print client connecting to RPM?  Whenever RPM is contacted for any reason, a log entry is created similar to 
"Information: Request from x.x.x.x” where "x.x.x.x" is the IP address of the computer that contacted RPM.  If you don't 
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see an entry like this, your print client is not getting through to the PC. Contact your network administrator for 
assistance. 

Does the print request arrive and sit in the RPM queue without printing?  Each queue in RPM has three different 
“states.”  Each state describes the current status of the queue.  Verify that the queue states are enabled, processing, and 
not holding.   If these states are set, RPM is in normal operating mode and should print each and every document that is 
received. 

The log file says "Failed subcommand" followed by other text. See #2.  We have had it reported to us that 
rebuilding the "/etc/printcap" file under Unix can solve this. Your results may vary. 

The log file shows "Error: Unable to print to <printer>.” The most likely causes are that the printer or port 
definition is wrong, or that the print driver can't be loaded. Also, Windows may temporarily be unable to talk to the 
printer. Check the log, since we continue to add diagnostic capabilities to RPM. For now we suggest going to Edit 
Queues and running Printer Setup, checking the definition of your printer, and possibly selecting another printer. 

Other Printing Problems 
Boxes and odd characters appear at the top of the first page, or in the printout. Your print application is sending 
printer specific data to RPM. Go to the Edit Queues dialog; near the top, you will see three queue types. The first is 
"Print text, allows font selection, page setup". This is selected by default. You want to use the second type, "Pass data 
directly to the printer (raw)." 

I send PostScript files and they print as PostScript code. See #1. 

I've selected "Pass through", but one line appears at the top of each page. Go to Edit Queues, click Queue Setup, 
then click "Translate LF to CR/LF". 

There is no page between print jobs in my raw queue. Go to Edit Queues, click Queue Setup, then click "Add Page 
Separator". 

I do not want a banner page to print. Go to Edit Queues, change the queue type to Text, click Queue Setup, then 
select the setting "Never print the banner page". 

Configuring RPM 
This topic provides a summary of the settings you can change in RPM, with pointers to the appropriate dialog Help 
topics. 

Hidden  
When RPM is minimized, the application icon  remains in the task tray, rather than appearing on the taskbar.  
Simply double-click the task tray icon to re-open RPM.  If you want RPM to execute completely hidden, without the 
task tray icon, simply right click on the RPM icon in the task tray and choose “Hide”.  You will be asked for 
confirmation. 
 
Later, if you decide to unhide RPM, import the “unhide.reg” file found in the RPM directory into the Windows 
registry, then reboot the computer.  The next time RPM is started, the task tray will have the RPM icon. 

Log File Expiration 
RPM creates a new log file every day, in the "Logfiles" folder directly beneath the RPM root. To keep your disk drive 
from filling, RPM will remove log files older than 7 days. You can change this value in the RPM Settings dialog (see 
page 52). 

Log File Timestamp 
RPM timestamps each log entry or other event it records. 
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Log Options 
By default, RPM enables network, print, and queue logging, but not high detail. See "Use logging options" on page 16 
for more information. 
 
If your RPM installation is running smoothly, you can turn off all the logging options. RPM will do minimal logging 
but warnings and error messages are always logged. 
 
If you are experiencing problems, we advise you turn on all the logging options until the problem is identified and 
resolved. 

Security 
In RPM, security consists of performing basic checks on new requests as advised in the LPD Protocol Specification or 
commonly implemented in the UNIX LPD server. Some print clients are not able to meet these requirements, however. 
The LPD Options dialog discussed on page 45 will advise you on how you can tell if you need to adjust these settings. 
 
RPM can also restrict access using Host Access which is discussed on page 41. 

Windows Print Manager 
In Windows 3.1, a limit in the number of print jobs was enforced by the print manager.  No more than 100 print jobs 
were allowed.  The Windows 95, 98 and Millennium Edition print manager does not have this limitation. 
 
RPM allows the user to control how many print jobs are sent from RPM to the Windows Spooler.  Normally this 
limitation is not needed.  The current version of RPM, by default, has the upper threshold of 900 and a low threshold of 
10 meaning RPM will submit jobs until there are 900 print jobs in the Windows Spooler, and then not submit jobs after 
that until the number of spooled jobs falls under 10.   You can also select the box to ignore these settings and always 
submit jobs. 
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Operations Guide  
This section goes beyond menus and dialogs. The intent is to show you what happens to your system when RPM runs, 
what files are created, and how RPM uses them. 

Starting RPM 
RPM performs a number of functions every time you start it. Several of these functions are mentioned in the topic 
Installing RPM and they are referred to here as installation functions. 
 
Each time you run RPM, it does the following: 

•  It executes the installation functions, to make sure RPM is installed properly and ready to run 
•  It loads a number of settings from the Windows registry 
•  It attempts to connect to WinSock and register itself as a print server. If it cannot, it displays an error and exits 

soon after 
•  It prompts you to create queues if you haven't already (this installation function is executed after the network 

setup) 
•  If you have queues, RPM performs a queue cleanup; in case of a system crash, partially transmitted jobs are 

removed, and jobs that were printing are held so that they can be printed later. 
•  All windows that were opened when RPM was closed last are restored.  If no windows were open, or if this is 

the first time RPM has been run on your computer, the Queue List and Log windows are opened. 
•  Finally, RPM checks for jobs ready to print and begins printing any waiting jobs. 

Exiting RPM  
When you exit RPM, the following actions take place: 

•  All the current transfers and requests are canceled, and incomplete jobs are removed. 
•  The network is informed that RPM will no longer be a print server. 
•  The current size, location, open windows, and show status (icon, normal, etc.) of RPM is saved. 
•  Finally, the main RPM window is closed. 

Files Created by RPM 
  Note: For a discussion of files that are more or less permanent, please see "Files used by RPM" below. 

 
When RPM receives a print request, it receives multiple parts. The first part is called a control file. This control file 
contains information describing the print request, including the title, the user ID, and instructions for printing it. 
 
The other part(s) of the request are the data file(s) to be printed.  Data files are stored in the spool directory, located in 
the directory where RPM is installed. The data file name is specified by the LPD protocol.  Usually it is 'df' followed by 
a letter, a series of digits, and the name of the host that sent the file. RPM will not overwrite files in the case of 
duplicate filename; rather it adds a “-1”, “-2”, etc. 
 
The user can specify that control files from the host be saved.  In this case, RPM saves the control data in a filename 
similar to the data file, beginning with a "cf" and using a .txt extension. This file is written to the spool folder, but this 
location can be customized. 

Files Used by RPM 
Unlike earlier versions of RPM, the current version of RPM does not create or maintain initialization (.ini) files. Instead 
RPM uses the Windows registry. 
 

  Note: We strongly recommend that you do not change the Windows registry without first making a backup of the 
current registry contents. You may damage your Windows system or make your system unbootable. 
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Queues  
This section is devoted to giving you a better understanding of queues. This is an important topic for two reasons: 

1. Queue management is one of the key features that sets RPM apart from other Windows based LPD servers and 
from hardware print servers 

2. Understanding queues is vital to getting the most value from RPM. 

Queue Types 
The current version of RPM supports three types of queues. The following discussion will help you understand what 
these types can do for you, and will help you select the right queue for your needs. 

Text queues 
Description: Text queues offer a wide variety of printing options, including the ability to set fonts, margins, line wrap, 
maximum page length, and many others. 
 
When to use: If you want RPM to read your text and render it using Windows features, then you should use a Text 
queue. 

Pass-through queues 
Description: Pass-through queues send print files directly to the printer, without interpretation. These queues still use 
the Windows Print Manager as Microsoft recommends. 
 
When to use: If you print files with special control codes, or files meant for a specific printer (including PCL or 
PostScript files), then you should use a pass-through queue. 

Filter queues 
Description: Filter queues execute a program on your computer or local network (in the case of file sharing), rather 
than sending the print job directly to the printer. 
 
When to use: If you have special processing needs which are best met by using another program in conjunction with 
RPM, then you should use a Filter queue.  For instance, you might use a Filter queue in one of the following situations: 
 

•  If you print PostScript files, but use a local PostScript rendering tool like GhostScript, as an alternative to a 
PostScript printer 

•  If you send word processing files to RPM for local printing; you could use your local word processing 
program to print the file to your Windows printer 

•  If you send a file to your computer to perform some function other than printing, for example updating a 
database or spreadsheet 

 

Queue States 
RPM provides several operating modes for queues that control how they accept and process requests. These modes are 
referred to as states. If it helps, you can think of a state as something that stays the way it is until you change it. 

Enabled or Disabled 
Description: When a queue is enabled, it accepts requests from remote print clients. When a queue is disabled, RPM 
will tell the remote print client that the queue is not defined. 
 
When to use: A good way to take a queue off-line is to disable it. For instance, if you are performing a full backup of 
your disk, or if RPM is spooling to a network drive and that network is currently not available, it may make sense to 
disable the queue temporarily. 
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Processing or Suspended 
Description: When a queue is suspended, RPM will not check it for ready print jobs.  Print requests will remain in the 
queue until it is resumed. When a queue is processing, RPM checks it for ready print jobs as usual. 
 
When to use: If a printer or filter program is temporarily unavailable, it makes sense to suspend the queue. 
 

  Note: if you suspend a queue, take care not to let your disk become too full. 

Holding or Not Holding 
Description: When a queue is holding, all jobs sent to that queue will be held until manually released via the Operator 
Job Control dialog (see page 46). If a queue is not holding, then jobs are still subject to the restrictions of Enabled or 
Suspended as discussed above. 
 
When to use: If you want to start jobs printing on a page other than the first, or if you wish to supervise the printing, 
then consider holding the queue. 
 
Mode Description When to Use: 

Enabled Accept incoming requests Normal mode for operation 
Disabled Deny incoming requests When performing backups, etc. 
Resume Process incoming data Normal mode for operation 
Suspend Do not process incoming data When printer is disabled for a period of time 
Not Holding Send print jobs to printer Normal mode for operation 
Holding Don't send jobs to printer Start printing on different page, or control printing 

How to Determine the Queue State 

The Queue List window 
The Queue List window shows the current states for each queue.  A checkbox for each state is provided. 

The Queue Status window 
The Queue Status window shows the current states for each queue. 

The Queues menu 
If the Queue Status window is open and a queue is selected, then the checkmarks next to Enabled, Processing and 
Holding in the Queues menu show the current state 

The Edit Queue dialog 
Select a queue in the “Edit Queues” dialog. The checkboxes in the General Setup group show the current states. 

How to Modify the Queue State 

The Queue List window 
A checkbox for each state is provided and when the box is toggled, the queue state changes immediately. 

The Queues menu 
If a queue is selected in the Queue Status window, then the Enabled, Processing and Holding items appear, possibly 
with checkmarks next to them. Select the item to change the setting. 
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Otherwise, the Enable/Disable, Resume/Suspend and Holding items appear. Select these items to change the setting via 
the Select Queue dialog (see page 53). 

The Edit Queues dialog 
In the “General Setup” section of the “Edit Queues” dialog are the controls for the queue states.  You can change the 
queue states for the selected queue by checking and un-checking these boxes. 

Host Access 
RPM is able to allow or deny access to other computers by using their Internet host name or address, and a set of rules 
that you supply. These rules and accompanying data are managed by the Host Access dialogs. 
 
Host Access is a tabbed dialog that gives access to three windows: 

•  Host Rules (see page 41) allows you to enter hostnames and domain name patterns, and access control 
•  IP Rules (see page 42) allows you to enter IP addresses and patterns, and access control 
•  Host Names (see page 44) allows you to enter a local host table, which RPM will use to convert IP addresses 

to host names. Otherwise RPM will use the network to look up a host name. 
 
This topic describes the overall host access security scheme. Also note our recommendation for structuring your rules. 

Access 
RPM optionally performs an access check for each connection it receives. Connections include print requests, queue 
status requests, and others. RPM is able to allow or deny access based on the identity of the remote computer. If access 
is allowed, then the request proceeds without the print client being aware that a check has taken place. If the access is 
denied, RPM returns the text "Permission denied." then closes the connection, effectively shutting off the request. 

Steps RPM uses when checking access 
1. Access checking enabled?  RPM uses a setting labeled “Enable host access checking” to determine whether 

or not to perform the access check. If this setting is off, RPM does not perform the check.  Enable host access 
checking is off by default, so that you do not have to create access rules to use RPM. 

2. Get the Connection IP Address, Use IP Address rules.  Whenever another program connects to RPM, 
WinSock provides to RPM the Internet address or IP address of the remote computer. RPM uses this 
information to search the IP rules you created. If a match is found, RPM uses the access control value (allow 
or deny) with this connection attempt. 

3. Search for host name.  If no match is found in the IP Address rules, RPM uses the IP address to search for a 
host name. It first looks in the IP addresses you enter in the Host Names dialog, then in the IP addresses for 
which WinSock has returned host names in the current RPM session.   If RPM does not find the IP address 
and a matching host name in its records, then it makes a WinSock request to retrieve the host name. You may 
need to have reverse DNS lookup enabled at your site; contact your network administrator(s) for more 
information.  If WinSock successfully finds a host name for this IP address, then RPM stores that association 
for later use in this session. 

4. Use Host name rules.  Assuming RPM has found a host name for the print client, it searches the host name 
rules you entered in the Host Rules dialog. If a match is found, then RPM uses the access control value for this 
connection request, as with the IP Rules match. 

5. Use Default access rule.  If no match is found in either the IP rules or Host rules, RPM uses the default access 
rule, either allow or deny, for this connection attempt. 

Rules 
RPM uses a series of rules that you create to determine whether or not a remote host has access. These rules consist of 
host names, domain name patterns, and IP addresses.  
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Rule Searching 
RPM uses two sets of rules you create: IP rules and Host rules. In each case, RPM starts with the first rule, and attempts 
to match each rule in order. RPM then uses the access value of the last rule matched. 
For example, let's assume the following set of rules: 
Rule  Access Host name or domain pattern 
1 Allow *.brooksnet.com 
2 Deny *.nicoh.com 
3 Allow *.shel.nicoh.com 
4 Allow africa.nicoh.com 
 
If we print from dave.dev.brooksnet.com, RPM finds a match in Rule 1, but continues to search the rules. No other 
rules match. 
 
If we print from s-03.shel.nicoh.com, RPM has the following results: 
Rule  Match Y/N Access 
1 N ? 
2 Y Deny 
3 Y Allow 
4 N Allow 
 
The result of this rule search is “allow”. 

Rule Matching 
Both host names and IP addresses come in parts separated by a period ("."); for example, the host name s-
03.shel.nicoh.com contains four parts: s-03, shel, nicoh, and com. RPM doesn't care how many parts there are. 
Similarly, the IP address 199.104.19.3 contains four parts, namely 199, 104, 19, and 3. For the purpose of pattern 
matching, RPM does not care how many parts there are in the name. 
 
The asterisk character (*) has long been used in the Internet as a wildcard for matching one or more "parts" of names or 
IP addresses. For instance, The domain pattern '*.brooksnet.com' matches both 'dave.dev.brooksnet.com' and 
'hp1.tech.brooksnet.com'. The asterisk matches "dave.dev" in the first example and "hp1.tech" in the second example. 
Similarly, the IP address pattern '199.104.19.*' matches '199.104.19.3', and the pattern '199.104.*' matches both 
'199.104.19.7' and '199.104.251.2'. 
 
By now you have probably noticed that host name rules are matched right to left, and IP rules are matched left to right. 
That is the Internet convention, which RPM uses as well. 

Default Access Rule 
RPM will use the default access rule if it cannot find a match in the IP rules or host name rules. 
IP addresses and host names 
 
Each computer using a TCP/IP network has a unique IP address. These addresses are either assigned individually by 
your network administrator, or automatically, perhaps with a DHCP server.  Each IP address also has a name associated 
with it. RPM is interested in the fully qualified domain name, that is, the complete path starting with the individual 
computer and ending with the domain. 
 
Our recommendations for working with host names and IP addresses follow: 

•  It is much easier to work with host names and domain patterns; unless you are the network administrator, in 
which case you probably know all the IP addresses and how they are grouped in your organization. 

•  If you work with host names, then your PC needs to know where the DNS is located. This information will be 
part of your WinSock setup. DNS stands for Domain Name Service; it is the software and database that turns 
names to addresses and addresses to names.  
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Recommendation 
We recommend that you use the most general rules first, followed by the more specific rules. In our rule searching 
example above we included the following: 
Rule  Access Host name or domain pattern 
2 Deny *.nicoh.com 
3 Allow *.shel.nicoh.com 
4 Allow africa.nicoh.com 
 
The most general of these rules is #2; access is denied to each host at nicoh.com. Next we allow all hosts in 
"shel.nicoh.com", finally, africa.nicoh.com is allowed. 
 
What would have happened if we put Rule #2 after Rule #4? The host s-03.shel.nicoh.com would match 
*.shel.nicoh.com and the access would be allow. But, later it would match *.nicoh.com and the access would now be 
deny. That would probably go against the intent. 

Styles 
Styles provide an easy way to store a queue setup, and conveniently restore it on demand. 

History 
The concept of styles grew out of a customer requirement. One of our clients told us they need to support four distinct 
print setups. We suggested that they create four queues, but they had already done so. Their problem was that each of 
their users had the same need for different print setups, and the job of remote administration to create these queues on 
the Unix host (4 * number of users) was becoming unmanageable; they preferred to have one queue per user. 
Our client requested that we make an easy way to "load" a queue setup on demand. RPM styles grew out of that. 
How to Use Styles 

1. Create a queue (see page 14), and set it up (page 14) to work well with one of your applications. 
2. Create a style (page 12), give it a name that ties in with your applications (e.g. "Transcripts"). 
3. Copy the queue setup to this style. 
4. To use this style, use the task tray menu (page 28) and select Use Styles (page 24). 

Translations 
RPM is able to perform character-by-character translations of your print data, prior to printing. This translation is 
independent of the queue type; in other words, you can translate text data, pass-through data, and data going to another 
program. 
 
For more information on the Translation Tables dialog, see page 59; for more information on the Character 
Translations dialog, see page 32. 
 

  Note: if you are translating pass through data, we strongly recommend that you test your results. Some printers do 
not support the complete Windows character set. 

What can you do with translations? 

Swap line feed and carriage return 
Most host applications generate a line feed, or carriage return followed by line feed, for a line terminator.  Windows 
printers generally need both a carriage return and a line feed to signal the end of the line.  We have also seen a line feed 
followed by a carriage return.  Your printer may understand this, but the RPM text handling sees an extra blank line. 
 
You can make RPM do the swap by following these steps: 
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1. Go to the Translation Tables dialog; you can get there from the Options menu by selecting Translations then 
Tables, or go to the Edit Queues dialog, click Print Data Options, then Edit Translations. The help topic shows 
you how to create a translation table. 

2. Create a table; let's call it "CRLF Swap", without quotes. Click the Contents button to create our translations. 
3. Put your cursor on the field Translate from / Enter hexadecimal characters. Click the CR button. Now click the 

LF button. That's our first translation. 
4. Now, click the LF button followed by the CR button. That's the second translation. 
5. Click OK in the Character Translations dialog, then OK until all dialog windows are closed. 
6. To use this translation: go to the Edit Queues dialog, click Print Data Options, select "CRLF Swap" from the 

Translation table drop-down list, then select Use Translation. 
From now on, any queue that uses this translation will swap the CR and LF characters. 

Translate unused ASCII characters to accented characters 
For example, you may want to translate certain characters to accented ASCII characters using the following data: 
Char From code (hex) To code (hex) New 
[  5b c4 Ä (AE) 
{  7b e4 ä  (ae) 
\  5c d6  Ö  (OE) 
| 7c f6 ö  (oe) 
]  5d dc Ü  (UE) 
} 7d fc ü  (ue) 
~ 7e df ß  (sz) 
@ 40 a7 §  (paragraph) 
 
To perform this translation, create a translation table as described above, you many want to name it "German".   Now, 
go to the Character Translations dialog, put the cursor in the Translate from / Enter hexadecimal characters field, and 
type the following: 
5bc47be45cd67cf65ddc7dfc7edf40a7 
 

  Note: Those are the to and from hex codes shown.  You do not need to click any buttons; RPM automatically 
enters the translations. 
 
When finished, save the table by clicking OK, then configure your queue to use the "German" translation table, also 
described above. 

Translation tables 
RPM stores translation information in named translation tables created by the “Translation Tables” dialog. This dialog 
allows you to create tables, rename existing tables, and delete tables. You can also edit the contents of the selected 
table. 

Character Translations 
RPM can also perform single character translations.  You specify a character to translate, what character to translate it 
to; then RPM will replace all instances of the first character with the second. 
 
RPM does not attempt to do multiple translations. For instance, let's say you want to change all A's to B's, and all B's to 
C's.  RPM will do exactly that; it will not change all A's to C's.  In other words, for each character in your print data, 
RPM performs exactly one translation, and then moves on to the next character in the data. 
 
The “Character Translations” dialog discussed on page 32 allows you to define these translations. 
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How To 
This section is a quick reference, dedicated to helping you use RPM in a hurry. We summarize a variety of topics that 
are explained in more detail else where in this manual. 

Create a New Queue 
Choose a name for the queue. This name should be short; eight characters or less is preferable, but RPM supports 
longer names as well. We recommend that the name be less than 64 characters. 

1. Select “New Queue” from the “Queues” menu, or click the New Queue button  on the toolbar. For more 
information on the Create a Queue dialog, see page 34. 

2. Type the name for your new queue in the “Create a Queue” dialog, and click OK. 
3. RPM now presents the “Edit Queues” dialog, and shows the default settings for your new queue. You can 

change the queue type, printer, and other settings from this dialog. 
 

  Note: If you need to change the operating characteristics of a queue, see the next topic. 

Change Queue Characteristics 
The easiest way to change queue characteristics is to double click on a queue in the Queue Status window. RPM opens 
the “Edit Queues” dialog for that queue. 
You can also change some of the characteristics from the “Queues” menu.  If no queue is selected in the Queue Status 
window, you will be presented with the “Select Queue” dialog. Choose a queue, click OK, and your work is done. 

  Note: You can invoke the “Edit Queues” dialog from the “Queues” menu, the Edit Queue  toolbar button, or 
the queue type button in the Queue List window, which is represented by one of the following images. 
 
Button Representation 

 
Text Queue 

 
Pass-through Queue 

 
Filter Queue 

Delete an Existing Queue 
If you have the Queue Status window open:  

1. Select a queue in the Queue Status Window. 

2. Use the Delete key on the keyboard, or click the Delete button  on the toolbar, or select Delete from the 
Queues menu. See page 24 for more information on the Queues menu. 

3. RPM opens the Delete Queue dialog, highlighting the queue you selected. See page 34 for more information 
on the Delete Queues dialog. 

4. If there are no active print jobs, or print requests still in transit, you may click the OK button to remove the 
queue. 

 
  Note: RPM will ask you for confirmation before you do this. RPM cannot recover a deleted queue, since it 

actually removes files and the registry keys. 
 
If you do not have the Queue Status window open: 

1. Open the Delete Queue dialog as shown in 2 above. 
2. Select a queue in the list of queues. RPM shows you the status of the jobs in that queue, if any. 
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3. If there are no active print jobs, or print requests still in transit, you may click the OK button to remove the 
queue. 

 
  Note: After you click the OK button, RPM checks the status of jobs in the queue again so that it doesn't remove 

active jobs. 

Rename an Existing Queue 
When you rename a queue, you change the name by which the queue is known to print clients, and the name used in 
RPM. 
 
To rename a queue: 

1. If the Queue Status window is open, select a queue by highlighting the line. 
2. From the Queues menu, select Rename. 
3. Select any queue in the Existing queue names list. 
4. Type a new queue name in the field marked "New name for queue". 
5. Click OK when you are done, or press the Enter key. 

 
  Note: RPM follows the same rules for queue names described in “Create a New Queue”.   There is more detail 

available for the Rename Queue dialog on page 52. 

Report Problems 
Our goal at Brooks Internet Software, Inc. is for you to receive the maximum benefit from our software products. 
Sometimes you may require assistance, even after you have reviewed the documentation. If this is the case, please 
contact us via email at support@brooksnet.com. 
 
If you are researching a feature and the documentation is unclear, we ask that you explain what it is you are looking for 
and how the documentation does not seem to help. If you have a suggestion on how it can be improved, please pass it 
along. Thanks in advance for your insight! 
 
If RPM does not seem to do what you expect, please tell us what you think it should do and why. We try to make the 
software easy to use. 
 
If RPM experiences a software failure, we ask that you do the following: 

•  From the Options menu, select Log. 
•  Set all the checkboxes on. 
•  Rerun your print job, or go through whatever steps are required to reproduce the problem 
•  Email the log file located in the RPM Logfiles folder along with a description of your problem to 

support@brooksnet.com 
•  Please be ready to send us further information if it is required to research the problem and find the correct 

solution. 

Determine Current RPM Activity 
The easiest way to see what RPM is currently doing is to open the Queue List (see page 18) and Log (see page 20) 
windows, and watch them as RPM receives and prints incoming data. You can also see a greater level of detail when 
printing with the Print Status window (see page 22). 
 
The highest level of detail is available in the Log window. By setting logging options (see below), you can see several 
levels of detail for network activity, commands and events related to queues, and for printing. 
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Use Logging Options 
Select “Log” from the “Options” menu (see page 25) to see the “Log Options” dialog.  For more information on what is 
logged, please see the “Log” window (see page 20). 
 
The Log Options dialog shows three categories of logging - network, print and queue logging. It also shows two levels 
of detail, on/off and high detail. 
 
When all logging is turned off, RPM logs startup information including the date and time, and RPM version number. 
Also, any errors that RPM encounters are logged. 
 
What happens when I turn on all logging? 
RPM runs a little slower due to the extra logging, and uses more disk space for the log.  
 
Does this make RPM work better? Differently? 
Yes and no. "Yes" because if there is a problem, then the detailed log helps our support staff to identify what is 
happening and either make a recommendation to you, or fix the problem in RPM. "No" is also true, because RPM 
performs the same actions whether it is logging or not. 

Network logging 
When network logging is turned on, you will see: 

•  WinSock status information when RPM starts 
•  The clients IP address for each request 
•  Warning messages when print clients violate security settings (see "LPD Security Dialog" on page 45) 
•  WinSock errors 

When high detail for network logging is turned on, you will also see: 
•  Status for incoming data. 
•  More detail on the LPD protocol. 

Print logging 
When print logging is turned on, you will see: 

•  Messages when queues are deleted or renamed 
•  When queue cleanup takes place during RPM startup (see page 7) 
•  Incoming queue requests from remote clients 

When high detail for print logging is turned on, you will see settings that RPM determines for you print job such as: 
•  Font name and size 
•  Line and page length 
•  Physical margins and line wrap, etc. 

Queue logging 
When queue logging in high detail is turned on, you will see: 

•  Messages at the start and end of print jobs 
•  A message when a filter command is run 
•  A message on which printer is used for a queue, whenever that information is accessed (for instance, during 

printer setup and font setup, as well as when printing) 

Save control file from host 
This setting, if selected, forces RPM to save the control file, which comes as part of the LPD print request. It will be 
automatically removed when the print job is complete. Support personnel from Brooks Internet Software, Inc. may ask 
for a sample of the control file captured with this method. 
 
You can also set the folder where RPM saves the control files.  This is done in the Print Data Options dialog which is 
discussed further on page Error! Bookmark not defined.. 
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User Guide  
This section explains the windows, menus, and dialogs used by RPM. For quick help on performing a particular 
function in RPM, check the “How To” section that starts on page Error! Bookmark not defined.. 

Main RPM window 
The main RPM window resembles a typical Windows application. Starting from the top, it contains a title bar, menus, 
toolbar, an area containing one or more smaller windows, and a status bar. The smaller windows may have scroll bars. 

Title Bar 

 
The title bar is located along the top of a window. It contains the name of the application and the currently displayed 
window.  To move the window, drag the title bar.  Note that you can also move dialog boxes by dragging their title 
bars. 
A title bar may contain the following elements: 

•  Application Control-menu button 
•  Document Control-menu button 
•  Maximize button 
•  Minimize button 
•  Name of the application 
•  Title of the active window 
•  Restore button 

Toolbar 

 
The toolbar is displayed across the top of the application window, below the menu bar. The toolbar provides quick 
mouse access to many tools used in RPM. Furthermore, RPM displays tool tips or "fly by help" when you leave the 
mouse cursor over a button on the toolbar for more than a few seconds. 
 
To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T). 
 

Click To 

 Create a new queue (see page 14) 

 
Edit an existing queue. RPM displays the Edit Queue dialog box, in 
which you can locate and edit the desired queue (see page 36) 

 Copy the contents of the active window to the clipboard (see page 24) 

 
Show the Operator Job Control dialog to give fine control over a print job 
(see page 46) 

 Remove a job or queue (see page 14) 

 Check all queues for jobs ready to be printed (see page 23) 

 
Display version and copyright information for your copy of RPM (see 
page 27) 

 
Invokes the Brooks License Manager (see page 29).  This allows users to 
view license status and license the software. 
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Enable the user to get help on any button on the toolbar, menu item, 
window or dialog 

Status Bar 

 
The status bar is displayed at the bottom of the RPM window. To display or hide the status bar, use the Status Bar 
command in the View menu. 
 
The left area of the status bar describes actions of menu items as you use the arrow keys to navigate through menus. 
This area similarly shows messages that describe the actions of button on the toolbars as you depress them, before 
releasing them. If after viewing the description of the button on the toolbar command you wish not to execute the 
command, then release the mouse button while the pointer is off the button on the toolbar. 
 
The right area of the status bar indicates the number of print jobs that Windows currently has queued. This number will 
increase every time RPM finishes a print job, or when another Windows application prints. Likewise, this number will 
decrease when the Windows Print Manager completes a print job.  You can also resize the RPM window on the right 
side of the status bar. 

Scroll Bars 
Scroll bars are displayed at the right and bottom edges of the window. The scroll boxes inside the scroll bars indicate 
your vertical and horizontal location in the document. You can use the mouse to scroll to other parts of the window. 

Queue List window 
The Queue List window is a split-pane window allowing users to access queue and job specific operations easily.  This 
window replaces the legacy “Queue Status” window from previous RPM versions. 

How To 

See Queues in Alphabetical Order 
Click the Queues column on the left window pane.  This sorts the queues in alphabetical order.  An up arrow  
indicates the column is sorted alphabetically in ascending order; a down arrow  indicates the row is sorted 
alphabetical in descending order. 

Delete all jobs in a queue 
Highlight the queue.  On the right pane, select the print job(s) you wish to delete.  Now, do one of the following: 

•  Click the Delete Job  button on the toolbar. 
•  Click the Delete keyboard button 
•  Choose Delete from the Jobs menu 

Select more than one job 
Highlight the queue to see a list of jobs currently in the queue.  On the right pane, select the print job(s) you wish to 
delete, hold, or unhold.  Press Ctrl+A to select all print jobs or use the Ctrl+Click with the left mouse button to select 
more than one. 
 

Queue List Left Pane 
On the left pane, each queue is listed by name, how many print jobs have been received since the user-interface was 
opened, and the number of print jobs currently in the queue, such as print jobs that are held or waiting for another task 
to finish. 
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Queue List Right Pane 
The right pane is also split into two sections.  The top of the pane shows the selected queue name, the status, and last 
operation performed on each queue.  It also provides access to easily open the “Edit Queues” dialog (page 36), the 
“Print Setup” dialog, and modify the queue states (page 8).  
 
The lower portion of the pane includes a scrollable list of print jobs in the currently selected queue.  The information is 
displayed in columns for ease of reading, with one job per line. 
 
From left to right the columns are: 

Column Description 
Job # A sequence number kept internally by RPM for each queue 
User ID The username sent in the control file from the client 
Host name The hostname of the client provided by TCP/IP 
Job title The title of the document provided in the control file by the client 
Activity Can be either Xfer, Print, Wait or Hold 
Detail Display will show Control, Data, Start, Banner or Page n 
Percent Can be anywhere from zero to 100% or Done 
Date The date and time of the data file or the start of printing 

Queue Status window 
The Queue Status window is a scrolling list that displays the queue names (see page 63), their current states (page 8), 
the last command received for the queue, and any jobs. RPM updates this display dynamically, without user 
intervention. 
 
The title of the Queue Status window includes the number of queues currently defined in RPM.  Selecting a queue in 
this window can accelerate virtually every function in RPM that uses a queue name. 
 

  Note: If you double click in the Queue Status window, RPM opens the Edit Queues dialog and displays the queue 
you selected. 
 
You can copy the entire contents of the Queue Status window to the clipboard by selecting Copy from the Edit menu 

(see page 24), or clicking the Copy button  on the toolbar. 
 
Following is a sample queue: 
Queue lp: Enabled, Processing, Not Holding 
Status: Printer ‘HP LaserJet 5’ is defined. 
 
The first line contains the text "Queue" and the name of the queue, followed by the current states.  The second line is 
the status of the queue; it contains the text "Status:", followed by the command. Whenever RPM receives a request for 
a queue, this line is updated. 
 
If you right-click on either of these two lines, a context menu will appear.  The menu contains 
four items: Open, Enabled, Processing, Hold queue.  The graphic shows a picture of the menu.  If 
you choose Open, you will be taken to the “Edit Queues dialog”, found on page 36), where you 
can modify the settings for the queue.  The other three choices change the “Queue States”.  More 
information on Queue States can be found on page 8. 
 
Following the command could be one or more jobs, if any jobs are present in the queue. The 
information is displayed in columns for ease of reading, with one job per line.  Similarly, if you 
right-click on one of the jobs, you will be presented with a context menu, which contains three 
items.  The items are: Open, Holding, and Delete.  From this menu, you can open the “Operator Job 
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Control dialog”, found on page 46.  You can also delete the job, and hold, or un-hold, the job.  There is a check mark 
next to “Holding” if the job is holding. 
 
From left to right the columns are: 

•  Sequence number (see the Glossary, which starts on page 63) 
•  User ID 
•  Host name 
•  Job title 
•  Activity: You will see either "Xfer", "Print", or "Wait". 
•  Detail: Display will show "Control" when receiving the control file, "Data" when receiving the data file, 

"Start" when beginning to print, "Banner" when printing the banner, or "Page n" when printing page 'n'. 
•  Percent, from zero to 100% or "Done" 
•  Date: The date and time of the data file or the start of printing 

Log window 
The Log window displays messages logged by RPM. This topic describes both the window and log messages; the topic 
"Use Logging Options" on page 16 describes how to control what is logged. 
 
The Log window is a scrollable list. One message appears on each line of the window.  Each message has a time-stamp, 
severity, and a message.  Some may also contain a source. 

  
Note that the title of the Log window is a filename containing the current date. This file is stored in a “logfiles” 
directory beneath the RPM directory.  The file is updated whenever a message is logged.  You can copy the entire 

contents of the Log window to the clipboard by selecting Copy from the Edit menu, or clicking the Copy  button 
on the toolbar. 
 
There are three categories of log messages: 

•  Information: Provides diagnostic information 
•  Warning: Denotes something needing your attention. 
•  Error:  Indicates a serious situation. 

 
The following graphic is a segment of an actual log file: 
 
Note the timestamp and the startup information. 
 
The following is a summary of the warning and errors that appear in the Log, with an explanation 

Text generated in RPM log Description of Problem: 
Cannot load printer driver The driver for this printer may have become corrupted 
Cannot run filter Windows 95 error running filter program 
Can't go to log dir RPM couldn't find the logfiles directory 
Can't go to queue dir RPM can't find the directory defined for a queue 
Can't start document printing Windows returned an error when starting a text print job 
Could not locate queue RPM can't find the queue you are renaming 



RPM version 2.5 Page 21

Creating directory RPM can't create the root directory 
Creating file RPM can't create a data file 
Creating queue dir RPM can't create a queue directory 
Error accepting new connection WinSock returned an error on a new request 
Error on queue 'queue' directory 'dir' RPM can't find a queue directory 
Error running Windows returned an error when executing a filter command line 
Error writing data file File error writing data received from remote host 
Failed command RPM has detected an apparent LPD protocol error 
Failed subcommand RPM has detected an apparent LPD protocol error 
Failed to change to drive RPM can't change to another drive 
Failed to create print status window RPM can't create the Print Status window 
Failed to create queue status window RPM can't create the Queue Status window 
Opening append file RPM couldn't open the file specified for appending 
Opening file for copy File error on filter 
Opening insert file RPM couldn't open the file specified for inserting 
Port is not defined by Windows The printer port returned by Windows is no longer defined 
Print error ending document Windows printing error 
Print error ending page Windows printing error 
Printer is not defined by Windows The configured printer is no longer defined 
Printing error Windows has returned an error status on finishing a page 
Printing-data file RPM can't read the data file for a text print job 
Printing-data file is empty the data file for a print job is empty 
Printing-reading control file RPM can't read the control file which defines a print job 
Problem resolving IP address Couldn't initiate call to WinSock to resolve IP address 
Queue not defined for protocol Go to Server Protocols and select a queue for this protocol 
Read error on Unexpected WinSock error getting data from remote host 
ResolveHost failed host name lookup Unexpected error; contact Brooks support 
Spool error Windows printing error on pass-through print job 
Spooling file Windows 95 printing error on pass-through print job 
Unable to interpret extra text RPM has detected an apparent LPD protocol error 
Unable to open file RPM can't open a data file for a print job 
Unable to open printer Windows 95 returned an error when printing a raw print job 
Unable to print to RPM can't print to this printer 
Unable to spool file Windows returned an error when starting a pass-through print job 
Windows has no default printer You need to use the Windows Setup to configure a default printer 
WinSock error resolving IP address The DNS server address is set properly in Windows Sockets 

There is one Abort message:   
Can't start WinSock RPM cannot connect to WinSock 
 
Many of these messages are self-explanatory, and some may require assistance from your local system administrator or 
networking staff. 

Resource Status Window 
The Resource Status view shows a list of all resources that various queues are configured output data to.  This includes 
all local and network printers and folders as well as filter programs that RPM may execute.  This window shows a grid 
view similar to spreadsheet applications and has seven columns.  The following list provides an explanation of each 
column. 
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Resource Name 
The Resource Name column displays the name of a printer with text or raw type queues.  With filter queues, this 
column may display the filter program or, if no program is in use, the function RPM is using such as "copy". 

Port 
The Port column is filled in with the Windows port that this printer is configured for.  If the resource is not a printer, 
this column is left blank. 

Driver 
The Driver column displays further information about the printer resource.  It is blank when the resource is something 
other than a printer. 

Status 
The Status column displays an icon representing the current status of the resource.  The icons and their respective 
meaning are shown in the table. 
     Icon Representation 

 The status is unknown, meaning it has yet to be tested 
 The resource has an error that was detected 
 The resource is busy or is currently being executed 
 The resource is up and ready to receive data 

 

# Printed 
The # printed column shows the number of print jobs processed by this resource since the user interface was opened.  
This information is reset when the RPM window is closed or the computer is restarted. 

# Waiting 
The # waiting column shows the number of print documents waiting to be printed.  These are documents that have been 
processed by RPM and sent to the Resource Scheduler but have not yet completed.  This information is reset when the 
RPM window is closed or the computer is restarted. 

# Queues 
The # queues column indicates the number of RPM queues that are submitting print data to the resource. 

Print Status window 
The Print Status shows a higher level of detail on print jobs than you can find in the other status windows, including: 

•  The queue name 
•  The sequence number (next to the text "Item") 
•  The user ID 
•  The host name 
•  The title 
•  The printer or the path to the filter program 
•  Detail, which includes the current page number, or the banner 
•  Percent 
•  Date, the date and time at the start of the print job 

 
You can copy the entire contents of the Print Status window to the clipboard by selecting Copy from the Edit menu, or 

clicking the Copy  button on the toolbar. 
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Menus 
File Menu 
The File menu offers the following commands: 
Command Action 
New queue Creates a new queue. 
Print Jobs Checks each job to see if it is ready to print. 
Export Exports existing queue configuration to a file. 
Import Imports a previously exported configuration from a file. 
Exit Exits RPM. 

New Queue  
Use this command to create a new queue in RPM. 
 
Shortcuts 

 Toolbar:  
 Keys: CTRL+N 

Print Jobs 
Use this command to print any ready jobs. Normally RPM does this automatically; if you have made changes to 
existing jobs that RPM is not aware of, then use this function. 
 
Shortcuts 

 Toolbar:  
 Keys: CTRL+P 

Export 
The export function allows you to save the existing queue configuration to a file.  The file is saved as a .reg file that 
allows you to import the configuration into any other computer.  This function can be used for backup purposes, 
moving configuration from one computer to another, or simply replicating queue configuration on each RPM 
installation. 

Import 
The import function allows a previously exported configuration to be imported into the Windows registry.  RPM will 
update the display after the registry import is completed. 

Exit 
Use this command to end your RPM session.  You can also use the Close command on the RPM Control menu. RPM 
cancels current transactions, but does not immediately abort a printing job.  
 
Shortcuts 
 Mouse: Double-click the Control menu button. 
  Click the Close  button on the far right side of the RPM title bar. 
 Keys: ALT+F4 
 
For more information, see Exiting RPM on page 7. 
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Edit menu 
The Edit menu offers the following commands: 
Command Action 
Copy Copies the contents of the active RPM window to the clipboard. 
Delete Deletes a job or queue from your RPM configuration 

Copy  
Use the Copy command to copy the contents of the active RPM window to the Windows Clipboard. 
Copying data to the clipboard replaces the contents previously stored there. 
 
Shortcuts 

 Toolbar:  
 Keys: CTRL+C 

Delete  
Use this command to remove a queue. Use the Operator Job Control command to delete a job. See page 46 for more 
information. 
 
RPM initially presents the Delete Queue dialog (see page 34), then provides you the opportunity to remove a queue. If 
you first selected a queue in the Queue Status (see page 9) or Queue List (see page 18) windows, RPM highlights that 
queue in the Delete Queue dialog. 
 
Shortcuts 

 Toolbar:  
 Keys: Delete 

Queues menu 
The Queues menu offers the following commands: 
Command Action 
New queue Add a queue to your RPM configuration (see page 14) 
Edit queues Change the settings for a queue (see page 14) 
Styles Invokes the Styles menu (see below) 
Operator Operator Job Control interface for selected job (see page 46) 
Delete Delete a queue (see page 14) 
Rename Change the name of a queue (see page 14) 
Enable/Disable Enable or disable a queue (see page 8) 
Resume/Suspend Resume or suspend processing for a queue (see page 9) 
Holding Specifies whether or not a queue or job is holding (see page 9) 
 
The Styles menu offers the following commands: 
Command Action 
Manage Styles Create styles and use queue settings in style (see page 54) 
Use Styles Copy style settings to a queue (see page 61) 
 

  Note: These options are discussed further on the pages listed. 
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Jobs menu 
The functions in the Jobs menu are available when viewing the Queue List window only.  From the Jobs menu, you can 
perform job specific functions. 
 
The Jobs menu contains the following commands: 
Command Action 
Open Access the Operator Job Control dialog (see page 46) 
Holding Toggles the job between holding and not holding job states.  
Delete Deletes the currently selected job. 
 

Options menu  
The Options menu offers the following commands: 
Command Action 
Settings Modify miscellaneous settings for RPM (see page 52) 
Log Modify logging options, levels of detail (see page 45) 
Host Access Manage settings to allow and restrict access from other computers (see page 10) 
Translations Invokes the Translations menu (see below) 
LPD Options Modify LPD protocol settings for RPM (see page 45) 
Protocols Manage protocol ports and settings (see page 53) 
Printer Limits Review or change printer limits 
  
The Translations menu offers the following commands: 
Command Action 
Tables Create named translation tables (see page 59) 
Contents Edit the contents of a translation table (see page 32) 
 

  Note: These options are discussed further.  Consult the listed pages. 

View menu 
The View menu offers the following commands: 
Command Action 
Toolbar Shows or hides the toolbar (see page 17) 
Status Bar Shows or hides the status bar (see page 18) 
Workbook Control whether RPM shows pages as a workbook (see page 17) 
Queue List Shows or hides the Queue List window (see page 18) 
Queue status Shows or hides the Queue status window (see page 19) 
Print status Shows or hides the Print status window (see page 22) 
Log Shows or hides the Log window (see page 20) 

Toolbar 
Use this command to display and hide the Toolbar, which includes buttons for some of the most common commands in 
RPM. A check mark appears next to the menu item when the Toolbar is displayed. 
See page 17 for help on using the toolbar. 

Status Bar  
Use this command to display and hide the Status Bar. A check mark appears next to the menu item when the Status Bar 
is displayed.  See page 18 for help on using the status bar. 
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Workbook 
RPM arranges windows as if they were separate pages, with a row of tabs at the bottom of the RPM window. This 
design resembles a workbook. 
You can return RPM to the traditional multiple window arrangement by selecting View/Workbook, then select it again 
to return to the workbook. 

Queue Status 
Use this command to display and hide the Queue status window, which shows the names and status of the queues 
currently defined in RPM, as well as status of any jobs. A check mark appears next to the menu item when the Queue 
status window is displayed. 
See page 9 for help on using the Queue status window. 

Print Status  
Use this command to display and hide the Print status window, which shows detailed status information for the current 
or most recent print job. A check mark appears next to the menu item when the Print status window is displayed. 
See page 22 for help on using the Print status window. 

Log  
Use this command to display and hide the Log window. A check mark appears next to the menu item when the Log 
window is displayed. 
 
See page 20 for help on using the Log window. 

Window menu 
The Window menu offers the following commands, which enable you to arrange multiple views of multiple documents 
in the application window: 
Command Action 
Cascade Arranges windows in an overlapped fashion. 
Tile Arranges windows in non-overlapped tiles. 
Arrange Icons Arranges icons of closed windows. 
Window 1, 2, ... Goes to specified window. 

Cascade 
Use the Cascade command to arrange multiple opened windows in an overlapped fashion. 

Tile 
Use this command to arrange multiple opened windows in a non-overlapped fashion. 
Arrange Icons Use this command to arrange the icons for minimized windows at the bottom of the main window. If 
there is an open window at the bottom of the main window, then some or all of the icons may not be visible because 
they will be underneath this window. 

Window 1, 2... 
RPM displays a list of currently open windows at the bottom of the Window menu. A check mark appears in front of 
the document name of the active window. Choose an item from this list to make its window active. 

Help menu 
The Help menu offers the following commands, which provide you assistance with this application:  
Command Action 
Help Topics Offers you an index to topics on which you can get help. 
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Using Help Provides general instructions on using help. 
License... Opens the BISI License Manager.  (See page 27) 
About RPM Displays the exact version of RPM. 

Help Topics 
Use this command to display the opening screen of Help. From the opening screen, you can jump to step-by-step 
instructions for using RPM and various types of reference information.  
Once you open Help, you can click the Contents button whenever you want to return to the opening screen. 

Using Help  
Use this command for instructions about using Help. 

License... 
When you select “License…” from the help menu, RPM runs the “BISI License Manager” program (BLicMgr.exe). 
This allows you to check the trial status, register RPM, contact the publisher and/or reseller via their website or sending 
e-mail, and print your RPM license if, in fact, RPM is licensed. 

About RPM 
This command displays the “About” dialog. See page 32 for more information.  

Control menu 
The “Control” menu is located at the upper left corner of the RPM main window, Queue Status, 
Log, or Print Status window, and some of the other dialog boxes. 
 
The Control menu offers some or all of the following commands: 
Command Action 
Restore Returns a window to an earlier size and position, after minimizing or maximizing 
Move Move the active window or dialog box 
Size Resize the active window 
Minimize Reduces the current window to an icon 
Maximize Increases the size of the current window to fill the display 
Close Closes the active window or dialog box 
Next Toggles open windows.  You open the queue status, log, and print status 

Restore 
Use this command to return the active window to its size and position before you chose the Maximize or Minimize 
command. 

Move  
Use this command to display a four-headed arrow  so you can move the active window or dialog box with the arrow 
keys. 
 

  Note:  This command is unavailable if you maximize the window.  You can also move the window by dragging 
the Title Bar. 
 
Shortcut 
 Mouse: Drag the title bar at the top of the window 



RPM version 2.5 Page 28

Size 
Use this command to display a four-headed arrow  so you can size the active window with the arrow keys. 
 
After the pointer changes to the four-headed arrow 

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the border you 
want to move. 

2. Press a DIRECTION key to move the border. 
3. Press ENTER when the window is the size you want. 

 
  Note:  This command is unavailable if you maximize the window. 

 
Shortcut 
 Mouse: Drag the size bars at the corners or edges of the window. 

Minimize  
Use this command to reduce the RPM window to an icon. 
 
Shortcuts 
 Mouse: Click the minimize button on the title bar. 
 Keys: ALT+F9 

Maximize 
Use this command to enlarge the active window to fill the available space. 
 
Shortcuts 
 Mouse: Click the maximize button on the title bar; or double-click the title bar. 
 Keys: CTRL+F10 enlarges a document window. 

Close  
Use the Close command to close the active window or dialog box. 
Double-clicking a Control-menu box is the same as choosing the Close command. 
 
Shortcuts 
 Mouse: Click the close button on the title bar. 
 Keys:  CTRL+F4 closes a window within RPM 
  ALT+F4 exits RPM or closes a dialog box 

Next 
Use the Next command to toggle between open windows in RPM.   Possible open windows could be the Queue Status, 
Log, and Print Status windows. 
 
Shortcuts 
Keys: CTRL+F6 displays the next open window. 

Task Tray Menu 
RPM supports a Windows task tray icon.  When you place the mouse cursor over the task tray 
icon, RPM shows the name of the product or the status, if jobs have been received or printed.  If 
you minimize RPM, it will hide itself. 
 
You can restore RPM by double clicking the task tray icon.  If you right click the task tray icon, 
RPM opens a menu.  This menu allows you to open the program window, see the “About” dialog, use a style, hide, or 
exit the program.  "Use style" will be unavailable when no styles have been defined. 
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Brooks License Manager 
The Brooks License Manager provides license management functions for software developed by Brooks Internet 
Software, Inc.  The license management software is provided with each application obtained from Brooks.  When the 
software is installed, a 21-day trial period is initialized.  Accompanying each purchase, instructions on unlocking the 
software are provided.  The Brooks License Manager is used for monitoring and unlocking the application. 
 
The Brooks License Manager software is used to perform the following functions: 

1. During a trial period, users can determine the number of days remaining before the trial period ends. 
2. View the installed modules, if any, and provide a way to license them. 
3. After the software is licensed, users may view and print the license information. 
4. Users can also view information about Brooks or the reseller, which includes contact information. 
5. Version number and copyright information for the license manager can be viewed in the About tab. 

License Status Tab 
During the trial period, this tab shows information about the license including the product, product version, serial 
number, and number of days remaining until the trial license expires. 
 
After the application is licensed through the License Wizard, information about the license is shown.  This includes the 
registered username and company, product and version, licensed date, when the support contract expires, and the serial 
number. 

Print License  
Pressing this button allows license manager to print the license information to a printer.  License manager can print to 
any available Windows printer, just as other applications do.  When pressing this button, the standard Print Setup 
dialog is displayed allowing the user to select the printer and change the properties. 
 

  Note: This button is available only after the software has been unlocked. 

Copy 
This button is used to copy the license information to the clipboard.  Users can then paste the information into another 
application for storing license information on disk, rather than printing it. 
 

  Note: This button is available only after the software has been unlocked. 

License 
Pressing this button invokes the Application Unlock Wizard, which allows the license to be updated.  After the initial 
licensing, this is used to update the support expiration date or change the registered username. 

Module Status Tab 
This tab contains a grid that displays modules that have been installed in easy-to-read columns.  This list shows the 
modules, the license status of the module, the quantity if applicable and a description of the module. 

License Module 
This button allows the user to unlock or update modules that are currently installed.  The Application Unlock Wizard 
must be completed prior to unlocking installed modules. 
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Publisher Tab 
This tab provides information about the publisher of the software.  Included here is the address, city, state, postal code, 
and country.  Phone and fax numbers are listed and links to contact the publisher via email or the website are also 
provided. 

Reseller Tab 
This tab provides information about the reseller of the software.  Included here is the address, city, state, postal code, 
and country.  Phone and fax numbers are listed and links to contact the publisher via email or the website are also 
provided if available. 
 

  Note: This tab is available when downloading the software from some resellers. 

About Tab 
This tab provides information about the Brooks License Manager.  Version and copyright information are displayed 
and links are provided to email and visit the publisher’s website. 

License Wizard 
The Application Unlock Wizard guides you through the steps of unlocking or updating the software license.  Each step 
is simple to follow; users provide information and the software is unlocked if all information is entered correctly. 
 
This wizard is accessed from the License Status tab of the Brooks License Manager application. 

Collecting Information 
This step is where you enter the user and company that the software is licensed to.  A unique username is required for 
each license.  If the username is not unique, the web unlock function will notify you. 

Determining Unlock Method 
The second step in unlocking the software is to determine whether to unlock using an unlock key or an order number 
and authentication code. 
 

  Note: A connection to the Internet is required when unlocking using the order number and authentication code.  

Entering Support Expiration 
This step is required only when unlocking using an unlock key.  This date is required to know when the support 
contract expires.  This date is typically one year to the date of purchase; it is shown on the invoice or can be obtained 
from Brooks.  If the support date is entered incorrectly, the unlock request will be unsuccessful.  This date is 
automatically transmitted when unlocking using an order number and authentication code. 

Edit… 
Pressing this button displays a calendar which allows you to select the correct date that support expires.  If you are 
unsure of the correct date, consult your sales receipt/invoice for the purchase date. 

Complete the Unlock Process 
This step is the final step in unlocking the software.  It is different depending on options chosen in previous steps, most 
notably the step “Determining Unlock Method”. 

Quantity 
Certain modules may require that a quantity be unlocked, such as the RPM Printers module.  If you have purchased an 
updated number of printers, enter the quantity here. 
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Unlock using an order number and authentication code 
Enter the order number and authentication code in the corresponding entry.  The sales receipt or invoice number is 
referred to as the order number.  There are also 3 choices corresponding to the automated way you prefer to unlock the 
software. 
 
When you select Web Unlock, License Manager will attempt to connect directly to our web server and transmit the 
encrypted license information to our server. 
 
When you select either of the email options, your default mail client is opened and populated with the information 
needed by Brooks to provide and unlock key.  Verify that the mail format is plain text so the server can correctly 
provide an unlock key.  This process is automated and can be used outside normal business hours.  

Unlock using an unlock key 
Enter the appropriate unlock key and the software will be unlocked.  This key is provided by Brooks either 
automatically from this wizard or by contacting Brooks directly.  Contact information is provided in the main License 
Manager window. 

Web Unlock 
Web Unlock requires the license manager to connect directly to our web server over the Internet.  License manager 
provides the ability to specify alternate proxy server settings.  The first time license manager is accessed, it reads the 
proxy server settings directly from Internet Explorer settings and populates the fields with this configuration. 
 
Users have the ability to specify alternate proxy server settings if Internet Explorer is not installed or not currently 
configured. 
 
Use HTTP proxy simply tells license manager that a proxy server is in use.  The Address and Port entries then become 
available and you can configure proxy settings here. 
 
Reset causes license manager to synchronize with the current Internet Explorer proxy server settings, if available. 
 

  Note: Proxy Server settings can be obtained from your network administrator. 
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Dialogs  
The following pages describe RPM dialogs. In most cases we include shortcuts that answer "how to" questions.  

About dialog 
The About dialog is accessed by selecting About RPM… from the 

Help menu or by clicking on the About button  on the 
toolbar.  Use this command to display the copyright notice and 
version number of your copy of RPM. 
 
This dialog box shows the user name and serial number for this 
copy of RPM. Both are contained in read only edit controls, 
which allows you to select and copy them to the Windows 
clipboard.  You will also find the contact information such as the 
email address for technical support and phone and fax numbers 
for Brooks Internet Software, Inc. 
 

  Note: Before you submit a problem report, please see 
“Reporting Problems” on page 15. 
 
 

Character Translations dialog 
The Character Translations dialog allows you to create and edit character 
translations, for a single translation table at a time. See page 12 for more 
information on RPM character translations. 

Shortcuts 

Translating Typable Characters 
In the Translate from, enter an ASCII character you wish to translate.  At this 
point, the cursor moves automatically to the Translate to field.  Enter an 
ASCII character here also.  The translation is added or updated and the dialog 
is reset, ready to add another translation. 

Translating Characters Using Hexadecimal Characters 
In the Translate from, enter a 2-digit hexadecimal number for the character 
you wish to translate in the appropriate field.  The cursor will automatically move to the Translate to field.  Now, enter 
the 2-digit hexadecimal number that you want the character to be.  When finished, the translation is added and the 
dialog is reset. 
 
RPM automatically adds the translation to the table and moves the cursor back to the “Translate from” field.   An 
ASCII table is included in this manual for convenience and can be found on page 64. 
 

  Note: RPM attempts to make the character entry easy.  You simply type the ASCII character or two-digit 
hexadecimal character.  RPM inserts or updates the translation. It also moves between the Translate from and 
Translate to fields automatically after entering the data. 
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Changing a Translation 
Do one of the following: 

•  Re-enter the translation as described above using the same "from" character and the desired "to" character. 
•  Select the translation from the list and enter a new "to" character. 

Removing a Translation 
Select the translation in the From/To list, and then click the button labeled Remove. 

Translation tables 
This drop list contains the names of currently defined translation tables. The contents of the selected table are shown in 
the From/To list. 
 
You can edit another translation table by selecting it in the Translation tables drop-down list. If any changes have been 
made to the current table, RPM will save those changes. 

From/To 
This list contains the current translations. RPM attempts to show each character as a printable value (e.g., 'a'), or 
symbolic value (e.g., 'ESC'); otherwise it will use the hexadecimal value. 
 
Select a translation in this list to edit or remove it. 

Translate from 
The Translate from area of the dialog contains two fields, one for entering an ASCII character, the other for entering 
two hexadecimal characters. 
 
If you put the cursor in the ASCII field and enter a character, RPM accepts that character and moves the cursor to the 
ASCII field in the Translate to area.  If you put the cursor in the hexadecimal field and enter two hex characters, RPM 
accepts them as a single character, and moves the cursor to the hexadecimal field in the Translate to area.  

Translate to 
The Translate to area of the dialog contains two fields, one for entering an ASCII character, the other for entering two 
hexadecimal characters. 
 
If you put the cursor in the ASCII field and enter a character, RPM accepts that character and adds or updates the 
translation.  If you put the cursor in the hexadecimal field and enter two hex characters, RPM accepts that as a single 
character, and adds or updates the translation 
 

  Note: If you enter anything but hexadecimal characters in the Translate from or to, that is '0' through '9' and 'A' 
through 'F', RPM beeps and refuses the character. 
 

Shortcuts 
These buttons are shortcuts to entering a tab, escape character, carriage return, line feed or form feed.  
 
If the cursor is in the Translate from area, the appropriate hex codes are inserted and the cursor is automatically moved 
to the Translate to area.  If the cursor is in the Translate to area, the appropriate translation is added to the list. 
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Remove 
Click this button to remove the currently selected translation.  This button will be disabled if a translation is not 
currently highlighted in the From/To list. 
 

Create a Queue dialog 
Use the Create a Queue dialog to create queues. After you have entered the 
queue name and clicked the OK button, RPM opens the Edit Queues dialog 
(see page 36) so queue characteristics can be configured. 

New queue name 
Enter a name for the queue. RPM allows queue names to contain alphabetic 
characters 'A' through 'Z' (upper and lower case), digits '0' through '9', dash ('-
') and underscore ('_'). White space characters such as space or tab are not 
allowed in a queue name. 

Existing queue names 
RPM displays the names of existing queues. As you type, RPM uses your input to search the existing queue names. If it 
finds a match, it selects the queue from this list. 
 
For instance, if you type the letter 'l' then the first queue in our example, 'lp', would have been highlighted. RPM does 
this to help the user avoid entering a name for a queue that is already in use. 
 
Continuing this example, if you typed the letter 'l' but followed it with a letter other than 'p', RPM would realize that 'lp' 
is not the intended queue name and will deselect that queue in the list. 

OK 
When you click OK, RPM checks to make sure the queue name entered is not already defined.  If not, RPM creates the 
new queue and displays the Edit Queue dialog.  If it is already used, an error is displayed and the queue is not created. 

Delete Queue dialog 
The Delete Queue dialog allows you to remove a queue, all the jobs in the 
queue and the queue configuration information.  See the section Delete an 
Existing Queue on page 14 for more information. 

How To 

Delete a Queue 
1. From the Queues menu, choose Delete. 
2. Highlight the queue you wish to delete. 
3. Press the Delete Queue button. 

 
The queue is deleted and the dialog is dismissed.  Note that you can select only a single queue to delete each time the 
dialog is invoked.  If any jobs currently in the queue are active, that is printing or being transferred, RPM will not allow 
the queue to be deleted. 
 

  Note: RPM does not provide an “Undo” operation.  Once the queue is deleted, it cannot be retrieved. 
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Edit Bytes dialog 
This dialog will assist you in creating a custom byte sequence. RPM uses this dialog to prepare bytes to insert before a 
print job, append to a print job, and as a page separator. 

How to 

Enter a typable character 
In the Current bytes field, RPM will display a position marker that looks 
like a plus sign over a minus sign (±). The position marker is shown in the 
dialog. 
 
Move the cursor to the field labeled Enter an ASCII character, and type a 
character. The character you type appears where the marker was, and the 
marker moves right. 

Enter a character using hex codes 
Locate the position marker in the Current bytes field. Now move the cursor 
to the field labeled Enter two hexadecimal characters and type your 2-digit 
hexadecimal number. The position marker moves right and character 
appears where it was. 

Move the insert point left or right 
The Left and Right buttons move the position marker left and right, respectively. 

Remove a character 
Move the position marker to the left of the character you wish to delete. Click the Del button. The position marker 
keeps its position, the deleted character disappears, and the remaining characters to the right of the deleted character 
move left. 

Enter special characters 
Position the cursor to the left of where you want the character to go; click the Escape, CR, or LF button.  These buttons 
are for the Escape key on the keyboard, a carriage return (Enter on the keyboard) and line feed, which tells the printer 
to start on the next line. 

Alphanumeric & Hexadecimal 
These settings control whether RPM tries to show characters by their symbolic value or the hexadecimal value. 

Current bytes 
This field shows you the current byte sequence in hexadecimal notation. RPM supplies a position marker that should 
resemble an arrow pointing down to a line. When RPM inserts a byte into the current bytes, it places it to the left of the 
position marker. 
 

  Note: You cannot change the bytes with this field; it is for display purposes only. 

Position and Length 
The Position field shows the location of the position marker, after which the next byte will be inserted. The Length 
field shows the length in bytes of the current bytes. 
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Left, Right, & Del 
The Left button moves the position marker one byte to the left. If the position marker is at the beginning of the current 
bytes, the Left button has no effect. 
 
The Right button moves the position marker one byte to the Right. If the position marker is at the end of the current 
bytes, the Right button has no effect. 
 
The Del button deletes the byte to the right of the position marker. If the position marker is at the end of the current 
bytes, the Del button has no effect. 

Enter an ASCII character 
Enter any character that you can normally type into a text field. RPM empties this field, inserts the byte in the current 
byte just after the position marker, displays it in the Current Bytes field, and adds one to the position and length fields. 

Enter two hexadecimal characters 
Use this field to enter bytes. The characters must be hexadecimal, either digits 0 through 9 or letters A through F. You 
can enter lower case a through f if you wish, and RPM will translate. 
 
If you enter anything else, RPM will display a dialog showing you which characters to enter, and will remove any 
characters in this field. The current bytes are unaffected. 
 
Once you have entered two hexadecimal bytes, RPM empties this field, inserts the byte in the current byte just after the 
position marker, displays it in the Current Bytes field, and adds one to the position and length fields. 

Shortcuts 
RPM inserts an escape character (ESC), carriage return (CR), line feed (LF) or form feed (FF) character as if you had 
entered the bytes manually. 

Edit Queues dialog 
Use the Edit Queue dialog to change queue settings.  Several other dialogs are invoked from this dialog, including Print 
Data Options (page 48), Printer Setup (page 51), Text Setup (page 56), Pass-through Setup (page 47), and Filter Setup 
(page 38). 
 

  Note: If any of the above dialogs are opened and changes are made, 
those changes are saved when that dialog is closed, not when the Edit Queues 
dialog is closed. 

How to 

Select a printer 
Click the Printer Setup button. This presents the standard Windows Print 
Setup dialog. Select a printer and any other options and click OK. RPM saves 
the printer information and optional settings for all future printing to the 
selected queue. 

Change queue settings 
Select the appropriate queue type from the Queue types group. Then click the 
Queue Setup button. 
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Get advanced features 
If you would like more advanced features of RPM such as transforming data, inserting or appending bytes and 
character translations, click the Print Data Options button. 

Select a queue 
This drop list contains the names of all configured queues. If RPM can make an intelligent guess about which queue 
you want to edit, it will display it here, otherwise, select it from the list. 
 
Use the drop list to select a different queue to edit. If you edit a queue with this dialog, and then select another queue 
with this drop-down list, all settings for the first queue are automatically saved. 

Queue types 
RPM supports several types of queues: Text, Pass-through, and Filter queues. Please see page 8 for a discussion of 
queue types. 

Queue Setup 
Click the Queue setup button to get a setup dialog appropriate for the current queue type. 

Print Data Options 
This button invokes the Print Data Options dialog, which is discussed on page 48.  These data options affect how RPM 
modifies the data before printing. 

Printer Setup 
RPM offers the standard Windows Print Setup dialog to allow the user to select printer settings for each queue.  RPM 
supports any options provided by the print driver. RPM stores these options; whenever a print job is received in this 
queue, the options you select are used.  
 
For instance, if you selected landscape printing rather than portrait in the Print Setup dialog, all print jobs sent to this 
queue will come out in landscape. Even when you shut down RPM or restart your computer, jobs from this queue will 
still be printed in landscape orientation. 
 

  Note: The print setup is only used for a Text type queue in RPM.  If you are using a “Pass-through” (raw) type 
queue, these options have no effect. 

Printer 
The name of the Windows printer, filter command, or destination folder is shown here. When a queue is first created, 
the Windows default printer is used.  Use the Printer Setup button to select a different printer or change the queue type 
to Filter and use the Queue Setup dialog to select a filter program. 
 

  Note: When a filter queue is selected, the Print Setup button is disabled.  If your data should be printed, use a raw 
or a text type queue. 

Enable this Queue to Receive Requests 
Queues can be enabled or disabled.  See Enable/Disable on page 8 for further information. 

Suspend Printing on Queue 
Queues can be suspended or resumed. Please Resume/Suspend on page 9 for more information. 
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Hold print jobs, operator controlled 
Jobs can be held until manually released. If the queue is set to Hold, then all jobs sent to it will be automatically held, 
and vice versa.  See Operator Job Control on page 46 for more information. 
 

  Note: Queue states are discussed in greater detail on page 8.  The default for incoming print data to be processed 
is to enable the queue and leave the suspend and hold settings turned off.   

Filter Setup dialog 
Use this dialog to edit settings for Filter queues. See page 8 for more information. 
 
How do I get RPM to leave the data file in a directory on my computer, without doing anything else to it? 

1. Specify an extension for the file, e.g. TXT or PS. 
2. Specify an existing directory to copy the files to. 
3. Leave the command line empty. 

Filename tab 

Use long filename 
RPM creates a filename for each incoming request.  Click this 
radio button if you would like to use RPM’s default filename.  
The long filename begins with ‘dfA,’ followed by a sequence 
number, ending with the DNS hostname of the sending side, if 
available.  

Use short filename 
In certain instances, you may want to provide your filter program 
with a short filename.  Clicking this button forces RPM to 
shorten the default filename, discussed above, into a short 
filename.  Short filenames use the DOS 8.3 naming convention 
where you have an 8-letter filename and a 3-letter extension.   

Use job sequence number 
Setting this option allows you to create your own filename for the filter.  An example of a customized filename is 
df0001.txt.  In this example, the filter filename is "df", there are 4 pad digits and the file extension is txt (this is set 
under the "File path" tab discussed below). 

Use filename from remote host 
The filename from the remote host may be used to identify the file.  This name is sent over in the control file and can 
only be customized on the sending side. 

Append to file 
By selecting this option, you can append the contents of the incoming data file to an existing file.  Click the browse 
button to select the file to append to.  If the file does not already exist, RPM will create a new file. 

Use Print Job Data 
This allows you to use information in the control file to save your data.  You can use such things as user, remote host, 
date and time, etc. for the name of the file.  See the Use Job Data dialog on page 60 for more information. 
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Filepath tab 

Directory path to copy files to 
RPM provides the ability to copy incoming data to a specified 
folder.  This may be useful when archiving the data or when a 
custom application is configured to “watch” a specific location for 
new files.  Use the Browse button to locate a folder. 

Use File Extension 
Your filter program may expect a certain file extension.  To use the 
file extension, place a check in this box and specify the extension. 
 

  Note: RPM is looking for the characters that follow the period 
(“.”) and will remove the period and anything that comes before it. For instance, *.txt becomes txt. 
 
If the filter is in the Windows directory or system directory, RPM uses the TEMP or TMP environment variables for 
the folder.  That way, critical system files are not affected. 

Execute Tab 

Program command line, with arguments 
Click the “Browse” button to locate the program you wish RPM to 
open when print data is received.  If the entire path is not specified, 
verify that the path to your executable can be found in the DOS 
PATH or RPM may suspend the queue. 
 
To specify the appropriate command line arguments, first consult the 
documentation for your filter program. 

How RPM handles the filename:  
To make RPM insert the filename inside a command line, use the 
string "%s". For example, the command line 
“C:\WINDOWS\NOTEPAD.EXE /p %s” will cause the Windows 
"notepad" utility to open the file, print it, and exit. 
 
Let's assume that RPM copies the data file from your print request to the path “C:\WINDOWS\TEMP\DF12.TXT". 
RPM will create the following command line for Windows:  C:\WINDOWS\NOTEPAD.EXE /p 
C:\WINDOWS\TEMP\DF12.TXT.  RPM will then execute this command line, and will log any problems encountered 
to the Log window. 
 
If the program command line does not contain "%s", RPM appends a space and the path of the data file to the command 
line before executing the filter program. 
 
Adapting our earlier example, let's say that the program command line is “C:\WINDOWS\NOTEPAD.EXE.”  Also, 
assume the data file path "C:\WINDOWS\TEMP\DF12.TXT".  RPM will execute the following command: 
C:\WINDOWS\NOTEPAD.EXE C:\WINDOWS\TEMP\DF12.TXT 
 
As before, RPM will then execute this command line, and will report any problems to the user. 

Show filter 
When a Windows program is executed, typically it is shown on the screen. Many users find it distracting to have 
application windows suddenly appear on the screen. 
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RPM gives you the option to "show" the filter program as an icon, a normal sized window, a full screen window 
(maximized), or not to show it at all (hidden). 

Delete temp files 
If RPM copies the data file to another location, it will optionally remove the new file after the filter program exits. 
We recommend that you leave this setting on, unless you have a need to keep these files.  If this setting is turned off, 
verify your disk space often to avoid running out of room. 
 

  Note: When RPM exits, it attempts to check the status of the filter program. If the filter program is still running at 
that time, RPM will not delete the temp file, and will not check later. You may need to perform your own temp file 
checks from time to time. 

Run one filter program 
We recommend that you run one filter program at a time. This will help ensure that your PC does not become 
overloaded if a number of filter jobs are sent at once. 
 

  Note: If this setting is off, RPM does not remove temporary files because it does not track the existence of the 
programs it executes. 

Translate LF to CR/LF 
Your host system may use only a line feed (LF) character to return to the next line.  If this is the case, select this option 
to insert a carriage return (CR) before each LF.  Most Windows printers and applications require both characters to 
represent the end of line.  When used separately, they usually represent other scenarios. 

Font dialog 
Use the “Font” dialog to select a font for your print jobs. This 
is the standard Windows font dialog for the selected printer. 
 

  Note: Only the fonts that your print driver supports will 
be displayed in this dialog.  For instance, your printer may 
support the ‘lineprinter’ font, but not all print drivers allow 
access to this font. 

Font 
This list shows the fonts that are currently available.  If a font 
is not listed, the print driver does not support it. 
 
Each font in this dialog is represented by an icon.  Each icon is 
explained in the following table. 

  
These are true- and open-type fonts that are rendered from line and curve commands.  These fonts scale well 
and can be easily stretched both horizontally and vertically.  These fonts are clean, even when the size is very 
large. 

  
These are raster or vector fonts that are rendered using bitmaps or drawn in an arrangement of line segments.  
Many of these types of fonts are provided only for legacy applications and output devices.  As these fonts get 
larger, they may appear with jagged lines and look worse than true type fonts. 

Font Style 
You can select that the font be regular, italicized, bold, or bold and italicized. 
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Size 
This option allows you to choose what size font to print.  RPM may ignore the font size when scaling the font to a 
particular width and height, such as when Error! Reference source not found. is selected in the Text Setup dialog 
(page 56). 

Sample 
The sample shows what the font settings you have selected looks like as it is printed or displayed, including the size 
and style selected. 

Script 
The script lists the available language scripts for your chosen font.  You will not necessarily be able to select the same 
script with a different font.  If you wish to use a particular script, then the font you select must also support it. 
 

  Note: RPM stores the font information for each queue; each time you print, RPM will use the font you selected for 
that queue.  The font size may also be dependent on other queue settings. 

Host Access dialog 
The Host Access dialog allows you to restrict access to RPM based on the IP address or DNS hostname of the system 
requesting to print.  By default, host access checking is disabled, allowing all hosts the ability to print through RPM.  
We recommend during initial configuration and testing that you retain the default settings.  Once RPM is functioning as 
expected, host access checking should be enabled and custom rules applied. 

Enable host access checking 
Check this box to make RPM check access on each connection attempt.  Uncheck the box to have RPM ignore access 
control. 

Default access rule 
Use the drop-down list to set the default access to “Allow All” or “Deny All”. The Host Access topic describes how the 
Default access rule is used. 
 

  Note: For a detailed description of host access and how to configure custom rules, see page 10. 

Host Rules Tab  
The Host Rules tab allows you to create and modify the host rules for 
access control, as described in the Host Access topic on page 10. You 
can also change the setting that toggles whether host access checking 
is enabled, and what the default access rule is configured for. 

How to 

Add a Rule 
1. Enter a host name or domain name pattern in the Hostname 

field. 
2. Select the type of access, either Allow or Deny, from the 

Access drop list. 
3. Click the Add button. 

Change a Rule 
1. Select a rule in the Host rules list. 
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2. Change the value in the Hostname field, and/or change the selection in the Access drop list, as appropriate. 
3. Click the Change button. 

Change the Order of the Rules 
1. Select a rule in the Host rules list. 
2. Click the Raise button to have this rule evaluated sooner; click the Lower button to have this rule evaluated 

later. 
 

  Note: The order in which the rules are applied can cause significant changes in whether the host is allowed or 
denied access. 

Host Rules 
The Host Rules list shows the current rules in order, with the first rule at the top. Each rule contains the access control 
(Allow or Deny) and a host name or domain pattern  
 
Select a rule in the Host Rules list. The host name and access appear below the list. You can also use the Raise, Lower, 
or Remove buttons if you have selected a rule. 

Host name 
The host name for the selected rule appears here. If you are creating or changing a rule, enter the host name here. 
Note that if the Host name field contains an asterisk character (*) that all characters to left of the asterisk will be 
removed when the rule is placed into the Host Rules list. 

Access 
This drop-down list shows you the current access, either Allow or Deny. 

Raise/Lower 
Click the “Raise” button to raise the priority of the selected rule, or cause it to be evaluated sooner. You cannot raise 
the first rule.  Click the “Lower” button to lower the priority of the selected rule, or cause it to be evaluated later. You 
cannot lower the last rule. 

Add 
Click this button to add the host name or domain pattern, and selected access, to the list of Host Rules. The new rule 
will appear at the bottom of the list. 

Change 
Click this button to change the selected rule. The new rule will use the text in the Host name field, and the selected 
access in the Access drop-down list. 

Remove 
Click this button to remove the selected rule. 

IP Rules Tab 
The IP Rules tab allows you to create and modify the IP address rules for access control, as described in the Host 
Access topic on page 10. You can also change the setting that toggles whether host access checking is enabled, and the 
setting for the default access rule. 

How to 

Add a rule 
1. Enter an IP address or pattern in the IP Address fields. 
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2. Select the type of access, from the Access drop list. 
3. Click the Add button. 

How to change a rule 
1. Select a rule in the IP Address rules list. 
2. Change the values in the IP Address fields, and/or change 

the selection in the Access drop list, as appropriate. 
3. Click the Change button. 

Use a rule sooner or later 
1. Select a rule in the IP Address rules list. 
2. Click the Raise button to have this rule evaluated sooner; 

click the Lower button to have this rule evaluated later. 

IP Address Rules 
The IP Address Rules list shows the current rules in order, with the 
first rule at the top. Each rule contains the access control (Allow or 
Deny) and an IP address or address pattern. 
 
Select a rule in the IP Address Rules list. The IP address and access 
appear below the list. You can also use the Raise, Lower, or Remove 
buttons if you have selected a rule. 

IP Address 
The IP address for the selected rule appears here. If you are creating or changing a rule, enter the IP address here. 

Shortcuts: 
Note that the IP address fields are divided into four boxes, much like the address itself. Each field accepts up to three 
numeric characters and automatically shifts focus to the next field. The last field shifts focus to the Access drop list. 
When you type an asterisk (*) in any of the fields, the remaining fields (those to the right) are emptied and focus shifts 
to the Access drop list. 
 

  Note: If any part of the IP address contains an asterisk character (*), all characters to right of the asterisk will be 
removed when the rule is placed into the IP Address Rules list. 

Access 
This drop-down list shows you the current access, either Allow or Deny. 

Raise/Lower 
Click the “Raise” button to raise the priority of the selected rule, or cause it to be evaluated sooner. You cannot raise 
the first rule.  Click the “Lower” button to lower the priority of the selected rule, or cause it to be evaluated later. You 
cannot lower the last rule. 

Add 
Click this button to add the host name or domain pattern, and selected access, to the list of Host Rules. The new rule 
will appear at the bottom of the list. 

Change 
Click this button to change the selected rule. The new rule will use the text in the Host name field, and the selected 
access in the Access drop-down list. 

Remove 
Click this button to remove the selected rule. 
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Hostnames Tab 
The Host Names dialog allows you to build a local host table for 
reverse name lookups; RPM looks for an IP address and wants to 
find a corresponding host name. 
 

  Note: Hostname and IP address patterns are not allowed in this 
dialog. 

How to 

Add an IP Address and Hostname 
1. Enter an IP address in the IP address field. These fields 

accept leading zeros and automatically move to the next 
field when you have entered three characters. 

2. Enter a host name in the Hostname field. 
3. Click the OK button. 

Change the Hostname for an IP Address 
1. Select the IP address in the Hostnames list. 
2. Change the host name in the Hostname field at the bottom 

of the dialog. 
3. Click the Change button. 

Hostnames 
The Hostnames list shows the current collection of IP addresses with corresponding host names.  Select an item in this 
list to modify or remove it. 

IP Address 
The IP address for the selected rule appears here. If you are creating or changing a rule, enter the IP address. 
 

  Note: The IP address is divided into four fields, much like the address itself. Each field accepts three numeric 
characters and automatically shifts focus to the next field. The last field shifts focus to the Access drop-down list. 
Unlike the IP Rules dialog, this dialog interprets each part of the IP address as a decimal number. The asterisk wildcard 
is not supported. 

Host name 
The host name corresponding to the IP address should be entered in this field. It is recommended that a fully qualified 
domain name is used when possible. 

Add 
Click this button to add the current IP address and host name to the Hostnames list. 

Change 
Click this button to remove the currently selected IP address and host name, and replace them with the fields entered 
above. 

Remove 
Click this button to remove the currently selected IP address and host name pair. 



RPM version 2.5 Page 45

Log Options dialog 
Use the Log Options dialog to set RPM logging options.  You can find a description of the RPM logging facility 
including an explanation of the following terms in the topic How to Use Logging Options on page 16. 

Enable network logging 
If this setting is on, RPM will log network events. 

High detail (network logging) 
If this setting and Enable network logging are both on, RPM will log 
network events in significant detail. 

Enable queue logging 
If this setting is on, RPM will log events for RPM queues. 

High detail (queue logging) 
If this setting and Enable queue logging are both on, RPM will log queue events in significant detail. 

Enable print logging 
If this setting is on, RPM will log printing events. 

High detail (print logging) 
If this setting and Enable print logging are both on, RPM will log print events in significant detail. 

Save Control File 
If this box is checked, RPM will save the control file to the disk along with the data file.  The name RPM will use for 
the control file will resemble the data file name, but it will have a “TXT” extension. 

LPD Options dialog 
The LPD Options menu option invokes the LPD Options dialog. These options 
involve the LPD protocol, a fairly esoteric topic. RPM can also allow and deny 
access based on the host name or IP address of the remote computer. See the 
Host Access topic on page 10 for more information. 

Relax the AF_INET requirement 
This option relaxes the requirement that the print client use a certain (typical) 
option in they way they connect to RPM.  If this requirement is necessary, the 
following message will be entered in the log. 
 
Client protocol: AF_INET is expected 
 
When this message appears, the client was prevented from making its request to RPM. This message is uncommon and 
is most likely due to a error in the client. 

Relax the 'port in range' requirement 
This relaxes the requirement that the client use a port in the reserved range, from zero to 1023.  If this option needs 
turned on, you will see the following message in the Log window. 
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Client port n is out of range 
 
When this message appears, the client was prevented from making its request to RPM.  The problem is most likely due 
to a program not following the RFC 1179 specifications. 

Operator Job Control dialog 
The Operator Job Control dialog allows you to delete a job, move a job to a different queue, specify a range of pages 
to print, and hold or release a job.  RPM does not allow a job to be deleted while it is being received or while it is 
printing.  

How to 

Delete a Print Job 
Jobs can be deleted when the Queue Status (page 9) or Queue List (page 18) 
windows are open.  RPM displays the current window in the application title 
bar. 
 
To delete a job, first highlight the job you wish to delete.  Click the Operator 

button  on the toolbar; then press the Delete Job button. 
 
If the queue is not suspended or the job is not holding, it may be processed 
before the delete operation is completed.  You should first suspend the queue 
(see page 9) or make sure the job is held.  If the job is not in transit, or being printed, the job will be deleted.   
 

  Note: There is no Undo operation.  Once the job is deleted, it cannot be retrieved except by printing it again to 
RPM.  RPM also removes the control file, and all associated data files. 
 

Release a Held Job 
Highlight the job in the Queue Status or Queue List windows and click the Operator toolbar button (shown above). The 
Operator Job Control dialog shows the job sequence number and other identifying information. 
 
If the job is held, then the Hold (set ON to print job later) checkbox is selected, uncheck it to release the job.  If other 
queue states are configured for normal operation, the job will be immediately printed and the job information will be 
removed from the Operator display. 

Move a Job from One Queue to Another 
Highlight the job in the Queue Status or Queue List windows and click the Operator toolbar button (shown above). The 
Operator Job Control dialog shows the job sequence number and other identifying information. 
 
Select the queue you wish to move the job to in the Queue drop list, then click the Move Job button. 

Queue 
The Queue drop-down list contains the names of the currently defined queues. When you select a queue, RPM puts the 
unique sequence number for all jobs in that queue in the Jobs list. 

Jobs 
The Jobs list contains the unique sequence number for all jobs in the queue selected in the Queues list. When you select 
a job, RPM displays identifying information for that job. 
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Item/User/Host/Title/Status 
These fields contain information describing the selected job. 

Starting/Ending page 
RPM is able to start printing on a page other than the first and finish printing before the last page. Enter a numeric 
value greater than 1 for the starting page if you want to skip pages.  If  “Ending page” is set to 0, then RPM will not 
finish until the job is completely printed. 
 

  Notes: For Text printing, RPM uses the values you enter in the Text Setup dialog (page 56) to count pages. 
However, for pass-through printing, RPM relies on page separators and your results may not be what you expect. 
 
If you choose a starting page greater than the last page RPM encounters when printing, it holds the job and alerts you 
with a dialog box. 

Hold (set ON to print job later) 
This checkbox is marked ON if the job is held. In this case, click the checkbox to immediately release the job for 
printing.  

Move job 
Click this button to move the current job to the queue you have selected in the to queue drop-down list. 

Delete job 
Click this button to remove the current job.  

Pass-through Setup dialog 
Sometimes with raw data, you may want RPM to make slight alternations.  
This should be done with plain text or text with escape sequences. 
 
It is not recommend using these options with binary files such as HPGL (the 
language of Hewlett Packard plotters), nor should they be needed with 
PostScript. However, you can experiment to see what works best in your 
situation. 

Translate LF to CR/LF 
When printing from a Unix operating systems or another systems that use a single character line terminator, you should 
select this option as most Windows printers may not print the data correctly.  Try selecting this option if you see a only 
a single line at the top of the page or a stair-step effect as shown. 
 
This is line one 
  This is line two 
    This is line three 

Add page separator 
In some situations, users may want to separate print documents with a separator page or send a form feed so your 
printer will eject the page after printing the job.  This option can be used in these situations. 
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Page Separator button 
By default, RPM uses the form feed character (hex 0C) as a page separator. Click this button to define your own page 
separator string, using the Edit Bytes dialog (see page 35). 

Print Data Options dialog 
The Print Data Options dialog allows you to make changes to your print data before printing.  These advanced features 
are available with all three queue types: text, raw, and filter.  For a description of queue types, see page 8. 

Transform Tab 

Remove PCL codes 
RPM can remove PCL, HPGL, and PJL codes from incoming data, 
leaving plain text.  These codes were developed by Hewlett Packard 
for use in printers, plotters and other output devices.  Note that RPM 
strips PCL codes automatically for text type queues. 

ASA carriage control / Fortran 
When this feature is enabled, RPM will translate data that is formatted 
with FORTRAN or ASA carriage control codes.  RPM will translate 
automatically when this box is unchecked if the LPR requested so 
using the standard Unix ‘-r’ option. 

Convert SCS to ASCII 
SCS is an EBCDIC based markup language found on IBM mainframes and AS/400 midrange systems. 
 
Select this setting to translate SCS markup commands.  If you are using a text queue then RPM reproduces the original 
formatting for many SCS commands.  Otherwise, RPM performs a simpler translation.  If you select this function, 
RPM assumes that it will also be doing EBCDIC translation and will use the selected language setting as described 
below. 

EBCDIC 
Select this setting to translate EBCDIC into ASCII, using the selected language setting as described below. 

Use (language) 
IBM has defined extensions to EBCDIC for many locales.  RPM currently supports these extensions for a variety of 
European languages.  Examples of extensions include but are not limited to accented characters and diacritics.  While 
RPM directly supports only characters found in ISO 8859-1, planned enhancements will provide support for a much 
broader range. 
 
RPM attempts to match the EBCDIC language extension to your computer's locale.  However, you can select any 
language setting. 

Use code page in non-text queues 
If this box is checked, RPM will translate the data to the selected code page.  Otherwise, RPM will not use the code 
page and not translate the data when using “raw” or “filter” type queues. 



RPM version 2.5 Page 49

Code Page 
This drop-down list contains all available code pages you have installed on your computer.  If you wish to print in a 
different language, and you do not have the code page available on your system, you cannot use that language.  
Microsoft will supply support for different languages. 

Translate Tab 
RPM can perform character-by-character translations; see the 
Translations topic for more information. 

Use translation 
Put a check in this box if you want RPM to perform translations. The 
translation table must also be selected for this to be in effect. 

Translation table 
The Translation Table drop-down list contains the names of the currently 
defined translation tables. The selected table will be used for this queue. 

Translation Tables 
Click this button for a shortcut to the Translation Tables dialog.  This way you can edit the contents of the translation 
table that RPM will use for this queue. 
 

  Note:  If you do not have a table selected in the “Translation Table” drop-down list, it brings up the Edit 
Translations dialog instead. 

Edit Translations 
Click this button to bring up the “Edit Translations” dialog.  

Insert Tab 
This function provides the ability to insert either a sequence of bytes or 
a file at the beginning of a print job. 

Insert function 
From this drop list, select the insert function you wish RPM to 
perform. Values are: 

Insert Function Description 
<none> RPM will not insert and data prior to printing it 
Insert bytes RPM will insert a byte sequence that you create 
Insert file RPM will insert the contents of a file 
 
The default function is "<none>", meaning RPM will not insert any 
data into the print job before printing. 

Edit Bytes 
Click this button to create or review the bytes that RPM will insert before a print job. RPM uses the Edit Bytes dialog 
(see page 35). This button is visible only when Insert Bytes is selected in the Insert function. 
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Browse 
Click this button to select a file for RPM to insert.  This button is visible only when Insert File is selected in the Insert 
function. 

File / Bytes 
A static control is also provided that displays the path to the file RPM will insert if you select the Insert file function or 
the bytes to be inserted if you select the Insert bytes function.  This is not visible until a file or sequence of bytes has 
been entered. 

Print Banner 
This option provides the ability to configure the banner page option.  You can configure RPM to never print a banner 
page (suppress banner), to print when requested by the sending side (when requested), and to always print, regardless 
of whether the client requests it (always print). 

Insert Location 
This option allows you to insert data either before or after the banner page. 
 

 Note: This option is disabled unless both insert function and print banner are in use. 

Append Tab 
RPM can append either a sequence of bytes or the contents of a file at 
the end of a print job. 

Append function 
From this drop list, select the append function you wish RPM to 
perform. Values are: 

Append Function Description 
<none> RPM will not append data prior to printing it 
Append bytes RPM will append a sequence of bytes 
Append file RPM will append the contents of a file 
 
The default function is "<none>", meaning RPM will not append any 
data before printing. 

Edit Bytes 
Click this button to create or review the bytes that RPM will append to a print job. RPM uses the Edit Bytes dialog (see 
page 35).  This button is visible only when Append Bytes is selected in the Append function. 

Browse 
Click this button to select a file for RPM to append.  This button is available when Append File is selected in the 
Append function. 

File / Bytes 
A static control is also provided that displays the path for the file RPM will append if you have selected the Append file 
function or the bytes to be appended if you have selected the Append bytes function.  This is not visible until a file or 
sequence of bytes has been entered. 
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Other Tab 
The Other tab provides further optional capabilities that are not 
categorized as transforming, translating, inserting or appending. 

Remove bytes at the start of the data 
When this setting is ON, then RPM will remove bytes from the 
beginning of a print job.  Do this if your remote host is sending text 
data that starts with some number of non-text characters. 

Number of bytes to remove 
Enter the number of bytes for RPM to remove. 

Place control files in this directory 
The control file is information sent by the client that describes information about the print job and how it should be 
formatted for printing.  Typical items found in the control file are: 
 

•  The job name, source file, or title to be printed on the banner page. 
•  Print format, which includes preformatted, postscript and others. 
•  Number of copies; an option not native to the LPR/LPD protocol, but included in some LPR client 

implementations. 
•  The DNS hostname of the client and the username who submitted it. 

 
Control files are not typically saved to disk.  You can force RPM to save the control file to disk with a setting in the 
Log Options dialog, found on page 45.  Here, you can specify a folder to save files to other than the default, which is 
the RPM Spool folder. 

Browse 
Press this button to find a folder that RPM will save the control files to.  This folder should be checked often to avoid 
problems with the disk filling up. 

Print Setup dialog 
The following options allow you to select the destination 
printer and its connection. 

Printer 
Select the printer you want to use. Choose the Default 
Printer; or choose the specific printer you wish this queue to 
print to using the Name drop-down list. 
 

  Note: You install printers and configure ports using 
the Windows Control Panel.  

Orientation 
Choose Portrait or Landscape. 

Paper Size 
Select the size of paper that the document is to be printed on. 
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Paper Source 
Some printers offer multiple trays for different paper sources. Specify the tray here. 

Properties 
Displays a dialog box where you can make additional choices about printing, specific to the type of printer you have 
selected. 
 

  Note: Print driver properties, orientation, and page source are not available in raw type queues.  For a description 
of queue types, see page 8. 

Rename Queue dialog 
The Rename Queue dialog changes the name of a queue in RPM. The topic 
"Rename an existing queue" on page 15 discusses this further.  This topic 
provides detail on using the actual dialog. 

Existing queue name 
This field shows the current name of the queue you are assigning a new name 
to. It is blank unless you selected a queue in the Queue Status window prior to 
opening the dialog, or until you select a queue in the Existing queue names 
list. 

New name for queue 
Fill in the new name you wish to use for the selected queue.  RPM treats upper and lower case the same for queue name 
comparisons, so you need not rename a queue from "lp" to "LP", for example. 

Existing queue names 
This list provides the names of the currently defined queues. As you type the queue name, RPM attempts to verify that 
the name is not already in use. RPM may highlight a name in this list if it matches what you have typed. This is only 
meant to inform the user of possible name conflicts. 

OK 
The Rename Queue dialog will attempt to rename the queue from the existing name to the new name, after filtering out 
invalid characters (such as space) and verifying that the new name is not already used for a queue. 

RPM Settings dialog 
The Settings menu option invokes the Settings dialog. The meaning of these 
items are explained in "Configuring RPM" on page 5. Below we offer 
guidelines for using this dialog. 

Log file expiration 
RPM keeps a log file for each day RPM is run.  The default number of days 
that RPM keeps each log file is seven.  After that, RPM will automatically 
delete them.  You can change RPM to keep the log files between 1 and 366 
days, or up to 1 year. 
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  Note: Exercise caution with this setting; as log files grow, they require more disk space.  If you save numerous log 
files, check the folder often to make sure your disk has enough space. 

Windows Print Manager 
The dialog requires the user to enter a value in the high threshold that is greater than the value in the low threshold. 
Both values must be between 1 and 30,000.  If there is more jobs in the Windows print spooler, RPM will not submit 
any more jobs. 

Create Queues 
When this function is in use, RPM will automatically create a queue if it gets request for one that is not already defined.  
The queue is created in a suspended to give users the ability to modify queue settings before printing.  At this point, 
you will need to change the options and printer selection for the queue before printing will resume.  This feature is on 
by default. 

Select Queue dialog 
This dialog automatically comes up if you try to change a queue state from the 
“Queues” menu without a particular queue being selected in either the Queue 
List or Queue Status windows. 

Select a Queue 
This list shows all queues that are currently defined in RPM.  Highlight the 
queue you wish to modify and press the OK button. 
 
Shortcut: 
Double-clicking on a queue is the same as highlighting a queue, and clicking the OK button. 
 

  Note: Click the Cancel button to dismiss the dialog without performing the requested operation. 

Server Protocols dialog 
RPM allows you to use TCP/IP printing protocols other than LPD.  It also 
allows you to listen for incoming LPD connections on other ports that the 
515 default. 
 
RPM supports the telnet printing protocol, also referred to as reverse telnet 
or stream printing.  This protocol requires you to enter a TCP/IP port 
number for RPM to bind to before data can be received. RPM also requires 
that you select a queue to process incoming print requests. 
 

  Note: Specialized clients use the streams protocol. If you are having 
problems printing in RPM, consult the "Common Printing Problems" topic 
on page 4 before changing any of the settings in this dialog. 
 
RPM allows you to define as many protocols as you like, and it will attempt to monitor all of them.  Restrictions are 
enforced so users cannot create different protocols listening on the same port number. 

How to Create a Telnet Port 
1. Select a protocol from the Protocol type list. This will almost always be telnet. 
2. Enter a port in the TCP/IP port field. For example, a typical port might be 100. Do not enter a port that is 

already in use. 
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3. Click the Setup button for more required configuration. 

Current protocols 
This list contains the currently defined protocols. Each protocol consists of a name and a port number. Names are either 
LPD or telnet; other names will be added if RPM supports additional protocols. The port number describes how TCP/IP 
finds a server, along with the IP address and other protocol information. 
 
The default port number for the LPD protocol is 515.  All known print clients expect to contact LPD print servers (e.g., 
RPM) on port 515. 

Protocol type 
When you define a new protocol, select the protocol type from this list. Chances are that most or all of your new 
protocols will be telnet and not LPD. 

TCP/IP port 
Enter a port number greater than zero (0) and less than 65,536. For telnet protocols, consult your network administrator 
or the person responsible for the streams print clients. 

Setup 
Click this button to get the Telnet Setup dialog (see page 55) for the selected protocol. RPM requires certain setup 
information for telnet protocols before it can accept input from telnet clients. 
 

  Note: LPD setup is global, not specific to the port number.  Therefore, no LPD setup is necessary. 

Add, Change and Delete buttons 
Click the Add button to add a protocol definition to the Current Protocols list.  Click the Change button to change the 
selected protocol to use the Protocol type and TCP/IP port values.  Click the Delete button to remove the definition for 
the selected protocol. 

Styles dialog 
This dialog allows you to copy settings from an RPM queue and store those settings in a named “style.”  You can 
create, rename, and delete styles using this dialog. 

How to 

Create a Style 
1. Enter a name in the Style Name field. 
2. Click the Add button. 

Copy Settings from a Queue 
1. Select a style in the Styles list. 
2. Select a queue in the drop-down list labeled Copy attributes of queue 

to selected style: 
3. Click the Copy button. 

Rename a Style 
1. Select a style in the Styles list. 
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2. Enter a new name in the Style name field. 
3. Click the Rename button. 

Styles 
The Styles list contains the names of the currently defined styles. Note that style names can contain spaces and other 
non-filename characters. 

Style name 
The Style name field allows you to enter a style name. 

Add Rename or Remove 
Click the Add button to add the name in the Style name field to the defined styles in the Styles list.  Click the Rename 
button to rename the selected style to the name entered in the Style name field.  Finally, click the Remove button to 
remove the selected style. 

Copy 
This button copies attributes of a queue to the selected style.  Select a queue from the drop list; when you click the 
Copy button, this queue will be the one whose attributes are copied.  Be sure you have a style selected. 

Telnet Setup dialog 
Use the Telnet Setup dialog to determine how RPM will print data sent to a telnet port. See the Server Protocols dialog 
on page 53 for more information on telnet ports. 

How to Configure a Telnet Port 
•  You must select a queue from the Submit jobs to queue drop list. 

This is required and there is no default. 
•  If you are doing text printing we recommend that you fill in the user 

name and title fields. 
•  The field Queue pages before printing determines whether RPM will 

print while connected, or wait until the connection is closed. 
•  Use the remainder of this topic to help determine whether to fill in 

the additional fields or leave them blank. 

Setup for protocol 
This field contains the protocol and port being configured. 

Submit jobs to queue 
Select a queue from this drop list. RPM will not accept data sent to this protocol without a queue to send it to. 

Print banner page 
RPM will suppress the text banner page if this setting is off. The banner page applies only to Text printing. 

Job name/User ID/Title 
The Job name field specifies a value for data that is typically sent by a print client.  The User ID field specifies a value 
for data that is typically sent by the client.  The Title field specifies a value for data that is typically sent by the client. 
RPM uses it during text printing and in various other features. 
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Use width 
The Use width field controls whether RPM will use the value in the Width field. An LPD print client sometimes sends 
width information, otherwise this setting, or the maximum width setting in the Text Setup dialog (see page 56) is used. 

Copies 
A print client may specify that RPM should print more than one copy of a print job. This field has the same effect. 

Print type 
A LPD print client typically specifies a print type. Choose a print type from this drop list. 

Queue pages before printing 
If the setting in Queue pages is zero, RPM will submit data received to be printed when the telnet connection is closed. 
 
If the setting in Queue pages is greater than zero, RPM will submit data to be printed when the number of pages it has 
received reaches or exceeds the setting, without waiting for the telnet connection to close. 
 

Print pages when quiet 
When this function is selected, RPM will print data it has received if the connection is quiet for ten seconds or more. 
 
When this function is not in use, RPM prints data only when the connection is closed. 
 
When to use this setting: This selection should be ON if your connection remains open for a long period of time, and 
you wish to print when the network activity stops temporarily. 

Text Setup dialog 
Use this dialog to edit settings used by text type queues (see page 8). Please 
note that there are many options, and that some options work differently 
depending on other values. Also note that additional dialogs that are accessed 
from the Text Setup dialog save their changes when closed, not when the Text 
Setup dialog is closed. 

How to 

Make Long Lines Shrink to Fit 
1. Select a font if you have not already selected one. 
2. Select Use characters per inch and/or Use lines per inch and input the 

appropriate lines/inch and chars/inch.  Formulas for calculating these 
values are provided below. 

Stop Printer Control Codes from Printing 
This ability is possible only in certain circumstances.  First, RPM removes 
PCL codes automatically.  Here are some guidelines in configuring RPM to not 
print “garbage” data. 

•  Try configuring your print client to use a PCL driver.  RPM 
automatically removes these codes without additional effort. 

•  Try setting Remove control characters.  
•  Try configuring your print client to not use a print driver at all, or configure it to use a plain text driver. 
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Stop Printing the Banner Page 
You can stop RPM from generating a banner page by selecting Never print the banner page.  If your remote host is 
generating a banner page, then we recommend that you hold the queue, and use the Operator Job Control dialog to 
begin printing on page 2. 

Make 60 Lines Fit on a Page 
Select the setting “Fit lines per page”.  Enter 60 in the lines/page field. 

See What Physical Margins My Printer is Using? 
From the Options menu, select Log, turn on the Enable print logging and high detail options. The RPM log window 
will show the physical printer margins when you send a job to that printer. 

Code Page List 
RPM queries Windows for the code pages installed on your system. For instance, if your computer has Japanese 
language support installed, Japanese will be included in this list. 
 
When you select a code page, RPM displays the Font dialog and instructs it to find fonts that support this language. 
 

  Note: If you select a wide character set such as Japanese, RPM has the following restrictions: 
•  It will not wrap lines. 
•  It will not print line segments (Use CR to overwrite lines). 
•  It will not remove control characters. 
•  It will not translate EBCDIC to ASCII, do SCS conversion, remove PCL codes, or use custom translation 

tables. 

Font 
The text on the button face shows the name and size of the font selected for this queue.  If the user does not select a 
font, RPM uses the default "Courier New 12". 
 
Press this button to change the font face, style, and/or size.  

Margins 
RPM provides the option to set margins for the printed page. RPM supports a number of widely used units for setting 
fonts, including Inches, Millimeters, Points, and Picas. If your industry uses a unit other than these, please send email 
to support@brooksnet.com describing your needs. When you change the unit of measure for the margins, RPM 
automatically converts the margin settings. 
 
Select margin units from the Margin Units drop list. Set your top, left, bottom, and right margins in the fields provided. 
 
RPM attempts to use true margins, taking into account the physical page size and non-printing area at the top and left of 
the page, according to Windows. RPM supplies 1/2 inch as a default margin for the top, bottom, left, and right edges of 
the page, but you should change these settings to suit your needs. 
 

  Note: The smallest margin your printer supports may be larger than the setting in RPM.  If this is the case, either 
the text will be cut off or the physical margins will be used; this is dependent on the print driver. 

Horizontal and vertical specifications 
RPM supports two ways each to specify horizontal and vertical sizes. You can Use lines per inch or Fit lines per page, 
not both.  Similarly, you can Use characters per inch or Fit columns per line, but not both.  The font height and width 
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are independent; if you specify both the width and height, RPM will stretch or compress the font. If you specify only 
the width or height, RPM preserves the normal shape of the font. 
 

  Note: RPM will use your selected font size only if the height is smaller than the font scaled height. For example, if 
you select an 8-point font and 6 lines per inch, RPM will use the smaller 8-point size and place the lines as you specify. 

Use lines per inch 
To use this function, check Use lines per inch and type a value in lines/inch setting; this forces RPM to print a specific 
number of lines-per-inch.  RPM reduces the font size automatically if necessary.  If the current font size is already 
small enough, that font size will be used. 
 
How to calculate lines per inch: On each page, I want to print contains 66 lines.  The paper setting is portrait and the 
page height is 11 inches.  The margins are set to 0.5 inches on both the top and bottom. 
LPI = 66 / (11 - (0.5 + 0.5)) = 6.6 

Fit lines per page 
When you select Fit lines per page and use a value in lines/page, RPM determines the vertical distance between the top 
and bottom margins, and calculates the font size that best matches the settings.  This setting may produce a slightly 
different result that the User lines per inch setting. 

Use characters per inch 
To use this setting, check the Use characters per inch box and specify a value in chars/inch field.  RPM will now 
generate a font of the appropriate width.  If you select both Use lines per inch and Use characters per inch, lines-per-
inch is reinforced by RPM and characters per inch may be reduced to accommodate your lines-per-inch settings. 
 
How to calculate characters per inch: The longest line in the file is 80 characters, the paper setting is portrait, and the 
page width is 8.5 inches.  The margins are 0.5 inches Left and Right 
CPI = 80 / (8.5 - (0.5 + 0.5)) = 10.66 

Fit columns per line 
RPM allows you to set a maximum line length, and specify whether or not it will be used. RPM considers tabs when 
calculating line length. When you select this option and specify a value in the Columns field, RPM calculates the 
correct characters per inch using the horizontal distance between the left and right margins. 
 
This setting works in conjunction with the Wrap lines setting. 
 
When you check this box, RPM turns on Wrap lines. With Wrap Lines on, and Maximum line length on, RPM will 
wrap lines using the length specified. 
 
If this setting is on but Wrap lines is off, RPM will truncate lines using the length specified. 

Use CR to overwrite line 
Some hosts use the line feed (LF) character to mark the end of a printed line, and the carriage return (CR) character to 
denote a line that is to be overprinted, or printed on top the current line. Select Use CR to overwrite line to cause RPM 
to recognize this convention. Otherwise, RPM treats LF, CR and CR/LF as line terminators. 
 

  Note: This setting is forced when using the ASA carriage control / Fortran setting in the Print Data Options 
dialog (see page 48). 
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Wrap lines 
RPM has the ability to wrap lines when the lines do not fit the page width. The way RPM does this depends on whether 
the Maximum line length is set or not.  If the Fit columns per line setting is selected, RPM uses the character count to 
determine if a line is too long, taking tabs into account. 
 
If Fit columns per line is unchecked, then Windows calculates the length of the line using the current font, and 
determines if the line will fit between the current left and right margins. 
 
If needed, RPM can use both white space, such as space (0x20) or tab (0x9) and non-word characters to find a place to 
break a line. Word characters are A to Z (upper and lower case), digits, and some punctuation characters. Dashes and 
hyphens are not included, so these can break a word. 

Remove control characters 
Our tests have shown that some systems insert NULL characters (that is, a character with the ASCII value zero) into a 
print job before sending it to RPM. Apparently some printers ignore these characters, but Windows does not. 
 
RPM gives you the ability to strip control characters from the file before printing. In this context, control characters are 
defined as characters with ASCII value less than the space (0x20), excluding carriage return (0x0D), line feed (0x0A), 
and form feed (0x0C). 

Use maximum lines per page 
RPM allows you to set the maximum number of lines to print on a page. RPM will pick the lesser of this value, if you 
specify it, and the value determined by the font, page size, and top and bottom margins. RPM uses the lines/page value 
from Fit lines per page. 
 

  Note: In most situations, Fit lines per page supercedes this function. 

Never print the banner page 
The LPD protocol specification says that the banner is printed by default, and the print client must suppress the banner 
for each job. However, RPM allows you to suppress the banner for a queue, whether the print client does or not. 

Suppress blank pages 
If this setting is on, then RPM will not print a new page following a form feed or blank lines exceeding the page height, 
until it sees data on the new page. Note that this setting is on by default. This should help RPM accommodate many 
mainframe based systems and save on paper costs. 

OK/Cancel 
The OK button closes the Text Setup dialog and saves changes.  The Cancel button closes the dialog without saving the 
changes except if you have changed the font, in which case, that change has already been saved.  Note that the Font 
dialog saves its own changes independent of the Text Setup dialog. 

Translation Tables dialog 
The Translation Tables dialog allows you to create and manage translation 
tables. See the Translations topic on page 12 for more information on RPM 
translations. 

How to 
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Add a Table 
1. Enter a table name in the Table name field. Use a name that does not already exist. 
2. Click the Add button. 
3. Click the Contents button to define a set of translations. See the Character Translations topic on page 32 for 

more information. 

Rename a Table 
1. Enter a new name in the Table name field. 
2. Select a table name in the Existing tables drop list. 
3. Click the Rename button. 

Edit the Contents of a Table 
1. Select a table name in the Existing tables drop list. 
2. Click the Contents button. The Character Translations dialog appears, with your table selected. 

 
  Note: If you do not define any contents for a table, RPM will not be saved. 

Existing tables 
The Existing tables drop list contains the names of translation tables already defined in RPM. This list is empty if none 
are defined. 

Table name 
The Table name field allows you to enter new and changed table names. As you type a name into this field, RPM 
searches the list of existing names and highlights a match, if found. 

Add/Rename/Delete 
Click the Add button to create a table; the contents of the Table name field are used for the new name.  Click the 
Rename button to change the selected table to the name in the Table name field.  Click the Delete button to remove the 
currently selected table, and the definitions in it. 

Contents 
Click the Contents button to edit the contents of the currently selected table, using the Character Translations dialog. 

Use Job Data dialog 
The Use Job Data dialog is used for saving filenames with 
customizable names.  There are now many ways to name files 
for ease of recognizing where, when, or who actually sent the 
file to RPM.  This may allow for better tracking in your 
organization.  

Available 
These are the options available for use in your filename that 
you have not already used.  There are a variety of things to 
choose.  For instance, if you want to save your file based on 
who sent it and when they sent the file, you would choose User 
and Date/time. 
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Used 
This is the box showing which options you have chosen to use for your filename.  The order they are listed from top to 
bottom is the same order as the name will be saved from left to right. 
 
This order can be customized two ways: 

1. Click and hold a value in this list and drag it either up or down in the priority. 
2. Remove all options below where you want a new stored, then insert them in the correct order. 

Add / Remove  
These buttons allow you to add available job data or remove used job data. 

Separator 
This is the character you want separating your data in the filename.  For instance you can make your filename 
'dave_www.brooksnet.com.txt' or 'dave-www.brooksnet.com.txt".  It just depends on what you want separating the 
data. 

Date/Time 
This is where you would choose the format for the date.  You can choose a 2-digit or 4-digit year, whether you want the 
year coming first or last, etc. 

Use Style dialog 
The Use Style dialog allows you to copy the queue settings saved in a style, back to a queue. This way you can easily 
change the behavior of an RPM queue. 

How to Copy a Style to a Queue 
1. Select a style from the Use style drop-down list. 
2. Select a queue from the Queue drop-down list. 
3. Click the OK button. 

Use Style 
Click the Use Style drop down list to select which style you want your queue to use. 

In Queue 
Click the In Queue drop list to select which queue to copy the style contents to. 
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New In This Version 
Version 2.5 
New features 

Resource Scheduler 
•  Provides faster turnaround for all printing tasks 
•  Uses resources with greater efficiency 
•  Includes new Resource Status window 

Print Error Recovery 
•  Printing resumes automatically when an error is resolved 

Brooks License Manager 
•  License Wizard enhances ease of use  
•  Supports advanced products and features  
•  Enhanced support for license reinstallation  
•  Web-unlock can connect through a proxy server/firewall  

User Interface 
•  Displays long job names  
•  Updated default settings  
•  Added support for importing and exporting configuration  
•  Changed "Resume" to "Suspend" 
•  Enhanced support for specifying control file destination  
•  Help file updated  
•  Filter queue disables printer selection  

Core 
•  Supports banner page for all queue types  
•  Improved file handling  
•  Updated default settings  
•  Allows insertion of bytes or files before or after banner page  

Issues Resolved 
•  Resolved issue with opening and closing queue display 
•  Resolved issue where dialogs were not using correct system colors 
•  Resolved issues in data with imbedded null characters, including ASA translations 
•  Resolved issue with blank page handling 
•  Batch files are now displayed by default when browsing for programs to execute. 
•  Fixed memory leak in filter queue processing 
•  Resolved issue with overwrite filename handler to overwrite with the correct name. 
•  Fixed issue where disabled queues were created again when a print job was requested to that queue name 
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Glossary 
Host name: A host name is the name assigned to a host computer on a TCP/IP network. It must be unique on the 
network; that is something your network staff usually takes care of.  Every computer on your network has its own 
name, from the mainframe to the PCs. Sometimes it is a one-part name, for instance, ws48 has only one part. At other 
times you might need to use a fully qualified name, such as ws48.brooksnet.com; this example is multipart. Your 
network staff can advise you on this. 
 
Often, you can substitute the IP address for a host name. Ask your network staff for assistance with this. 
 
Print job: RPM can receive several kinds of requests. One of these requests actually results in printing, so it is referred 
to as a print job. The other requests RPM might receive result in RPM returning status information, and sometimes 
performing an action on a queue or one or more jobs. 
 
RPM spends most of its time dealing with print jobs. First it receives a print job, each of which contains several parts 
(see "Files created by RPM" on page 7). Then RPM stores it in a queue, and later processes it. Finally, RPM removes 
the job. 
 
Queue: In RPM, a queue is a list of print jobs, each with a common destination. RPM queues are uniquely identified by 
their name.  Each queue has characteristics that you can set in the Edit Queues dialog (see page 36). For instance, two 
queues might use the same Windows printer, but each queue might use different fonts, or one might use portrait and the 
other landscape. 
 
Queue name: Each queue has its own unique name.  Queue names cannot contain "white space", that is, spaces or tabs. 
This would violate the LPD Protocol specification, which describes how information is passed between print clients 
and servers.  RPM treats queue names as case insensitive; that means upper or lower case does not matter. For instance, 
you can define the queue "lp" and clients can use queue "LP" or "Lp" or “lP”; these letter combinations all refer to the 
same queue. 
 
Root directory: The root directory plays two roles in RPM. First, it contains the spool directory.  Second, it is the 
directory that contains the log files directory.  Future versions of RPM may create other directories in the root 
directory. 
 
Sequence number: RPM assigns a sequence number to each print job, based on information found in the queue.ini file 
in the queue directory. You may notice this number in the Queue Status window (see page 9) in the far left column. 
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ASCII Codes 
ANSI Character Set (Character Codes 0-255) 
 
Dec Hex Char Code† 
0 00 � NUL 
1 01 � SOH 
2 02 � STX 
3 03 � ETX 
4 04 � EOT 
5 05 � ENQ 
6 06 � ACK 
7 07 � BEL 
8 08 � BS 
9 09 � HT 
10 0A � LF 
11 0B � VT 
12 0C � FF 
13 0D � CR 
14 0E � SO 
15 0F � SI 
16 10 � SLE 
17 11 � CS1 
18 12 � DC2 
19 13 � DC3 
20 14 � DC4 
21 15 � NAK 
22 16 � SYN 
23 17 � ETB 
24 18 � CAN 
25 19 � EM 
26 1A � SIB 
27 1B � ESC 
28 1C � FS 
29 1D � GS 
30 1E � RS 
31 1F � US 
32 20 (space)  
33 21 !  
34 22 "  
35 23 #  
36 24 $  
37 25 %  
38 26 &  
39 27 '  
40 28 (  
41 29 )  
42 2A *  
43 2B +  
44 2C ,  
45 2D -  
46 2E .  

47 2F /  
48 30 0  
49 31 1  
50 32 2  
51 33 3  
52 34 4  
53 35 5  
54 36 6  
55 37 7  
56 38 8  
57 39 9  
58 3A :  
59 3B ;  
60 3C <  
61 3D =  
62 3E >  
63 3F ?  
64 40 @  
65 41 A  
66 42 B  
67 43 C  
68 44 D  
69 45 E  
70 46 F  
71 47 G  
72 48 H  
73 49 I  
74 4A J  
75 4B K  
76 4C L  
77 4D M  
78 4E N  
79 4F O  
80 50 P  
81 51 Q  
82 52 R  
83 53 S  
84 54 T  
85 55 U  
86 56 V  
87 57 W  
88 58 X  
89 59 Y  
90 5A Z  
91 5B [  
92 5C \  
93 5D ]  
94 5E ^  

95 5F _  
96 60 '  
97 61 a  
98 62 b  
99 63 c  
100 64 d  
101 65 e  
102 66 f  
103 67 g  
104 68 h  
105 69 i  
106 6A j  
107 6B k  
108 6C l  
109 6D m  
110 6E n  
111 6F o  
112 70 p  
113 72 q  
114 72 r  
115 73 s  
116 74 t  
117 75 u  
118 76 v  
119 77 w  
120 78 x  
121 79 y  
122 7A z  
123 7B {  
124 7C |  
125 7D }  
126 7E ~  
127 7F �  
128 80 € 
129 81 � 
130* 82 ‚ 
131* 83 ƒ 
132* 84 " 
133* 85 ... 
134* 86 † 
135* 87 ‡ 
136* 88 ˆ 
137* 89 ‰ 
138* 8A Š 
139* 8B ‹ 
140* 8C Œ 
141 8D � 
142 8E Ž 
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143 8F � 
144 90 � 
145 91 ' 
146 92 ' 
147* 93 " 
148* 94 " 
149* 95 • 
150* 96 - 
151* 97 - 
152* 98 ˜ 
153* 99 ™ 
154* 9A š 
155* 9B › 
156* 9C œ 
157 9D � 
158 9E � 
159* 9F Ÿ 
160 A0   
161 A1 ¡ 
162 A2 ¢ 
163 A3 £ 
164 A4 ¤ 
165 A5 ¥ 
166 A6 ¦ 
167 A7 § 
168 A8 ¨ 
169 A9 © 
170 AA ª 
171 AB " 
172 AC ¬ 
173 AD - 
174 AE ® 
175 AF ¯ 
176 B0 ° 
177 B1 ± 
178 B2 ² 
179 B3 ³ 
180 B4 ´ 

181 B5 µ 
182 B6 ¶ 
183 B7 · 
184 B8 ¸ 
185 B9 ¹ 
186 BA º 
187 BB " 
188 BC 1/4 
189 BD 1/2 
190 BE 3/4 
191 BF ¿ 
192 C0 À 
193 C1 Á 
194 C2 Â 
195 C3 Ã 
196 C4 Ä 
197 C5 Å 
198 C6 Æ 
199 C7 Ç 
200 C8 È 
201 C9 É 
202 CA Ê 
203 CB Ë 
204 CC Ì 
205 CD Í 
206 CE Î 
207 CF Ï 
208 D0 Ð 
209 D1 Ñ 
210 D2 Ò 
211 D3 Ó 
212 D4 Ô 
213 D5 Õ 
214 D6 Ö 
215 D7 × 
216 D8 Ø 
217 D9 Ù 
218 DA Ú 

219 DB Û 
220 DC Ü 
221 DD Ý 
222 DE Þ 
223 DF ß 
224 E0 à 
225 E1 á 
226 E2 â 
227 E3 ã 
228 E4 ä 
229 E5 å 
230 E6 æ 
231 E7 ç 
232 E8 è 
233 E9 é 
234 EA ê 
235 EB ë 
236 EC ì 
237 ED í 
238 EE î 
239 EF ï 
240 F0 ð 
241 F1 ñ 
242 F2 ò 
243 F3 ó 
244 F4 ô 
245 F5 õ 
246 F6 ö 
247 F7 ÷ 
248 F8 ø 
249 F9 ù 
250 FA ú 
251 FB û 
252 FC ü 
253 FD ý 
254 FE þ 
255 FF ÿ 

 
� Indicates that this character is not supported by Windows. 
• Indicates that this character is available only in TrueType fonts. 
 
† The "Code" column is meaningful only for characters 1-31. 


